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実習スケジュール 

1 日目 

9:30-10:20     スケジュールの説明など 

10:20-10:50    cDNA 合成準備 

10:50-12:50    cDNA 合成反応開始（2h） 

・10:50-11:50 実験に必要な試薬、器具の確認 

ラベル化反応の概要 

DNA マイクロアレイの基礎(ppt) 

・11:50-12:50  <昼食 （1h）> 

12:50-13:10    cRNA 増幅&ラベル化準備 

13:10-15:10    cRNA 増幅＆ラベル化反応（2h） 

・13:10-14:10   サンプル及び cRNA のチェック方法の説明(ppt) 

             マイクロアレイ実験に役立つストラタジーン製品のご紹介(ppt) 

・14:10-14:20   <休憩> 

・14:20-15:00   ハイブリチャンバの組み立てとハイブリの練習 

15:10-15:40    cRNA 精製 

15:40-16:30    バイオアナライザ、NanoDrop による cRNA のチェックと濃度測定 

16:30-16:45             フラグメンテーションの準備 

16:45-17:15    フラグメンテーション（30min） 

17:15-17:30    ハイブリダイゼーション準備 

17:30-       ハイブリダイゼーション開始 

 

2 日目 

9:30-10:00   遺伝子発現データの特長、スキャナの基本性能(ppt) 

10:00-10:30             アレイ洗浄方法の説明・解体練習 

10:30-11:10  アレイ洗浄、スキャナ操作 

11:10-11:20  <休憩> 

11:20-12:00  オゾン対策の説明、DNA マイクロアレイの遺伝子情報(ppt) 

12:00-13:00   <昼食 （1h）> 

13:00-13:20   イメージファイルの確認方法 

13:20-14:00   Feature Extraction アルゴリズム(1 カラー)の説明(ppt) 

14:00-14:10   <休憩> 

14:10-15:30  Feature Extraction による数値化 

15:30-15:40  <休憩> 

15:40-16:00   1 カラー実験の Normalization 法の説明(ppt) 

16:00-16:40   遺伝子発現解析ソフト（GeneSpring GX）デモ 

16:40-16:45  Q&A、まとめ（→1 色法の実習終了） 

16:45-17:10  2 カラー実験の数値化概念（→2 色法対象）(ppt) 
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1．はじめに 

アジレント・テクノロジーでは、マイクロアレイ実験をされる実務者の方を対象にDNAマイクロアレイ カス

トマニュースを配信しています。実験プロトコルのアップデート・新製品のご案内・実験に関するトラブル

シュート・試薬や消耗品の保存など、実験を成功させるためのテクニカルサポートに内容を限定して、月

1回程度E-mail でお送りしています。受信をご希望の方は「DNAマイクロアレイ カストマニュース配信希

望」と明記して、お名前・ご所属・配信を希望する E-mail アドレスを下記宛先までお知らせください。 

 email_japan@agilent.com 

 

本操作実習テキストは、アジレント 60-mer オリゴ DNA マイクロアレイを用いた 1 色法解析における、

推奨ラベル化、ハイブリダイゼーション、洗浄、スキャニングと数値化の手順を記載しています。 

 

1 サンプル 1 アレイで、シグナル強度を測定 

 

Ver.5.7_JP での更新点 

 実験に使用する Agilent キット fragmentation buffer のチューブに含まれる内容量の記載を 

改訂しました。 

 必要なものリストを見やすくしました。 

 ラベル化 cRNA の NanoDrop による評価の記述を簡便化しました。 

 ハイブリエイドの使い方の絵を一部修正しました。 

 オーブンの写真を型番 G2545A のものに変更しました。 

 Appendix：FE 用 Protocol のダウンロードサイトページのリンクを修正し、「現在」の日付を 

2017 年 4 月に変更しました。 

 デザインファイルのダウンロード方法のリンクや情報を修正し、「現在」の日付を 

2017 年 4 月に変更しました。 

 

 

 

mailto:email_japan@agilent.com
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Ver.5.7 での更新点  

 ラベリング試薬が、the Low RNA Input Linear Amplification Kit PLUS から Agilent Quick Amp 

Labeling Kit に変更になりました。 

 アレイ洗浄のアーティファクトリスクの軽減のため、Triton X-102 が GE Wash Buffer1 と 2 に 

加えられました。  

 必要なものリストに、Triton X-102 が加えられました。 

 アレイ間補正の基準値として、コントロールプローブを除いた全プローブの 75%tile 値が 

    より堅牢であるとの記載が加えられました。 

2015 年 8 月変更点 

 保証期間の記述を変更しました。 

 

プロトコルは予告なく変更になることがあります。プロトコルを日本語化するにあたり、作業時間が発生

するため、日本語プロトコルは英語の最新バージョンに比べて、遅れが生じます。製品ご購入の際は、

必ず製品添付の英語版プロトコルの Version をお確かめの上、日本語版が古い場合は、最新の英語

版を参照ください。 
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2．実験に使用する Agilent キットの確認 

 

Quick Amp Labeling Kit, one-color 20 反応分 

（製品番号 5190-0442） （※本キットは、Cyanine 3-CTP を含みます） 

＜内訳＞ 

 Cyanine 3-CTP （10 反応分チューブ×2 本） 

 Quick Amp Labeling  Kit 単品（製品番号 5190-0447 

この製品番号の商品は Cyanine 色素が含まれません。） 

 

Component  Volume 

MMLV-RT 45 µL  

T7 Promotor Primer 30 µL 

RNase Inhibitor 25 µL 

Inorganic Pyrophosphatase 15 µL 

5x First Strand Reaction buffer 195 µL  

4x Transcription buffer 430 µL 

10 mM dNTP mix 25 µL 

NTP mix 175 µL 

0.1M DTT 230 µL 

T7 RNA Polymerase 20 µL 

50% PEG (Polyethylene glyco 140 µL 

 

※本キットは、-20℃以下で保存してください。 

※Cy3-CTPは開封前は-20℃、融解後は4℃で保存してください。 

※Cy3-CTPのみの販売はしておりません。 

 

 

アジレント RNA Spike-In キット (1 カラー用) 

（製品番号 5188-5282） 

One-Color Spike-Mix (10 uL) 

Dilution buffer  (1.2 mL) 

※全ての試薬は-80℃で保存してください。 
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アジレント Gene Expression Hybridization Kit （製品番号 5188-5242） 

 

Component 

25 x フラグメンテーションバッファ (400-500 uL) 

2 x GE Hybridization Buffer HI-RPM (1.25mL x 2 本) 

10 x Blocking Agent (凍結乾燥) 

※ 本キットは開封するまでは室温で保存してください。 

※ 10 x Blocking Agent を調製した後は、この試薬のみ-20℃で保存してください。 

※ 本キットの使用可能アレイ数は下記のようになります。 

244K 10 アレイ 

2x105K 20 アレイ 

4x44K 45 アレイ 

8x15K 100 アレイ 

 

アジレント Gene Expression Large Volume Hybridization Kit （製品番号 5190-0404） 

※ 本キットは Gene Expression Hybridization Kit と比べて各フォーマットとも 10 倍のアレイ数に

使用可能です。 

※ Large Volume Hybridization Kit の各試薬は個別に購入することが可能です。 

2 x Hi-RPM Hybridization Buffer (5190-0403) 

25 x Fragmentation Buffer (5185-5974) 

10 x Blocking Agents (5188-5281) 

 

アジレント Gene Expression Wash Buffer 

 Gene Expression 洗浄バッファ 1 4L （5188-5325） 

 Gene Expression 洗浄バッファ 2 4L （5188-5326） 

 

アジレント Gene Expression Wash Pack 

Gene Expression 洗浄バッファ 1 （5188-5325） が 2 個、Gene Expression 洗浄バッファ 2

（5188-5326） が 1 個および TritonX-102 (1.35mL のチューブ 6 本) のセットです。 

 

必要なソフトウェア 

 １x244K、2x105K、4x44K フォーマットのアレイの解析のためには下記ソフトウェアが必須です 

 アジレントスキャナをご使用の場合、スキャンコントロールソフトウェア version A.7.0.1 以降 

 数値化ソフト Feature Extraction ソフトウェア version 9.1 以降 

8x15K フォーマットのアレイの解析のためには下記ソフトウェアが必須です 

 アジレントスキャナをご使用の場合、スキャンコントロールソフトウェア version A.7.0.1 以降 

 数値化ソフト Feature Extraction ソフトウェア version 9.5 以降 
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アジレント オリゴ DNA マイクロアレイ 

 

244K フォーマットのアレイは、 

１枚のスライドグラスに１枚のアレイが載っています。 

 

 

 

244K フォーマットのアレイ 

 

2x105K フォーマットのアレイは、 

1 枚のスライドグラスに 2 枚のアレイが載っています。 

 

 

 

2x105K フォーマットのアレイ 

 

4x44K フォーマットのアレイは、 

１枚のスライドグラスに 4 枚のアレイが載っています。 

 

4x44K フォーマットのアレイ 

 

8x15K フォーマットのアレイは、 

1 枚のスライドグラスに 8 枚のアレイが載っています。 

 

 

 

8x15K フォーマットのアレイ 

 

オリゴ DNA マイクロアレイキット中には、アレイのレイアウトとアノテーション情報が記載された

CD-ROM、及び実験プロトコルが添付されています。 

 

※アレイは室温で保存して下さい。フォイル開封後は暗所・室温で、真空デシケーター中か、窒素 

パージした箱の中で保管して下さい。開封後は、マイクロアレイスライドを外気にさらさないで

下さい。 
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3．実験に必要な試薬 

アジレント 遺伝子発現実験に必要なものリスト 
※ 指定 ： 必ず指定されたものをご使用ください。指定品以外を使用された場合は保証の対象外になります。 
※ 推奨 ： 安定した結果を得るために、推奨品の使用をお奨めします。推奨品以外の製品を使用された場合、 

アプリケーションサポートの対象外になります。 
※ 相当 ： コメント欄に記載された条件を満たすものなら、何を使用されてもかまいません。 

用途 品名　（アレイフォーマット） 製造メーカー 品番
指定/
推奨/
相当品

必要量 備考

アレイ Whole Human Genome (4x44K) Agilent G4110F － 4アレイ X 2スライドグラスで１キット

アレイ Whole Human Genome (4x44K) Agilent G4112F － 4アレイ X 5スライドグラスで１キット

アレイ Whole Mouse Genome (4x44K) Agilent G4121F － 4アレイ X 2スライドグラスで１キット

アレイ Whole Mouse Genome (4x44K) Agilent G4122F － 4アレイ X 5スライドグラスで１キット

アレイ Whole Rat Genome (4x44K) Agilent G4130F － 4アレイ X 2スライドグラスで１キット

アレイ Whole Rat Genome (4x44K) Agilent G4131F － 4アレイ X 5スライドグラスで１キット

アレイ Chicken (Gallus) (4x44K) Agilent G2519F015068 －

アレイ Magnaporthe II (4x44K) Agilent G2519F015060 －

アレイ Mouse Development (4x44K) Agilent G2519F015062 －

アレイ Rhesus Monkey (4x44K) Agilent G2519F015421 －

アレイ Gallus gallus(4x44K) Agilent G2519F015068 －

アレイ Yeast (4x44K) Agilent G2519F015072 －

アレイ Xenopus laevis (4x44K) Agilent G2519F015066 －

アレイ Rice  RAP-DB(4x44K) Agilent G2519F015241 －

アレイ Bovine (4x44K) Agilent G2519F015354 －

アレイ Soybean(4x44K) Agilent G2519F016047 －

アレイ Drosophila(4x44K) Agilent G2519F021791 －

アレイ Zebrafish(Danio rerio) (4x44K) Agilent G2519F019161 －

アレイ O.aries(8x15K) Agilent G4813A019921 －

アレイ S.Salar(4x44K) Agilent G2519F020938 －

アレイ Porcine ver.2(4x44K) Agilent G2519F020109 －

アレイ C. elegans (4x44K) Agilent G2519F020186 －

アレイ A.gambiae(4x44K) Agilent G2519F020449 －

アレイ O.cuniculus (4x44K) Agilent G2519F020908 －

アレイ N.tabacum(4x44K) Agilent G2519F021113 －

アレイ Arabidopsis ver.4 （4x44K) Agilent G2519F021169 －

アレイ Canine ver.2(4x44K) Agilent G2519F021193 －

アレイ E.caballus(4x44K) Agilent G2519F021322 －

アレイ Barley(4x44K) Agilent G2519F021623 －

アレイ Tomato(4x44K) Agilent G2519F022270 －

アレイ Wheat(4x44K) Agilent G2519F022297 －

アレイ Brassica(4x44K) Agilent G2519F022520 －

アレイ Cotton(4x44K) Agilent G2519F022523 －

アレイ Medicago(4x44K) Agilent G2519F022524 －

アレイ Custom Microarray Agilent － カスタムアレイ

ラベル化
Quick Amp Labeling Kit, One-

Color
Agilent 5190-0442 指定 1反応/アレイ

20反応分(Cyanine3-CTPが20反応
分含まれます)

ラベル化 Quick Amp Labeling Kit, two-color Agilent
5190-0444

指定 ２反応/アレイ
20反応分(Cyanine3-CTPが10反応
分、Cyanine5-CTPが10反応分含ま
れます)

ラベル化 Agilent One Color Spike Mix Kit Agilent 5188-5282 指定 1色法用のスパイクイン

ラベル化 Tow-Color Spike-In Kit Agilent 5188-5279 指定 2色法用のスパイクイン

ラベル化 Qiagen RNeasy mini kit Qiagen 74104 推奨

50精製分,１ラベル化反応に

１本使用します。２５０本入り
は　74106です。

ラベル化
エタノール (95-100%),
Molecular biology grade

相当
分子生物学実験に用いる純度の高
いエタノールを準備してください。

ラベル化＆
ハイブリ

DNase/RNase-free Distilled

Water 500mL
Invitrogen 10977-015 推奨 適量
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＊ Cyanine 3-CTP は、使用するまで-20℃以下での保存を推奨しております。凍結融解の繰り返しを避

けるために、開封後は 4℃、遮光状態で保管してください。 

 

＊ ハイブリダイゼーションバッファはマイクロアレイキットおよびラベル化キットには含まれておりません

ので、必ずアジレント Gene Expression Hybridization Kit をお求めください。 

 

アレイは室温で保存して下さい。フォイル開封後は暗所・室温で、真空デシケーター中か、窒素パージし

た箱の中で保管して下さい。開封後は、マイクロアレイスライドを外気にさらさないで下さい。 

 

用途 品名　（アレイフォーマット） 製造メーカー 品番
指定/
推奨/
相当品

必要量 備考

ラベル化
エタノール (95-100%),
Molecular biology grade

相当
分子生物学実験に用いる純度の高
いエタノールを準備してください。

ラベル化＆
ハイブリ

DNase/RNase-free Distilled

Water 500mL
Invitrogen 10977-015 推奨 適量

ハイブリ Gene Expression Hybridization Kit Agilent 5188-5242 指定

20アレイ分（2x105K）

または10アレイ分(244K)

または45アレイ分（4X44K)

または100アレイ分(8x15K)

ハイブリ
Hi-RPM Gene Expression

Hybridization Kit (Large volume)
Agilent 5190-0404 指定

200アレイ分（2x105K）

または100アレイ分(244K)

または450アレイ分(4x44K)

または1000アレイ分(8x15K)

ハイブリ
2 x Hi-RPM Hybridization Buffer

(25ml)
Agilent 5190-0403 指定 5190-0404に含まれています。

ハイブリ 25 x Fragmentation Buffer (10ml) Agilent 5185-5974 指定 5190-0404に含まれています。

ハイブリ 10 x Blocking Agents Agilent 5188-5281 指定 5190-0404に含まれています。

ハイブリ MilliQ水 推奨

洗浄
Gene Expression Wash Buffer 1

(4L)
Agilent 5188-5325 指定 500 mL程度

洗浄
Gene Expression Wash Buffer 2

(4L)
Agilent 5188-5326 指定 250 mL程度

洗浄 Gene Expression Wash Pack Agilent 5188-5327 指定
5188-5325が2個5188-5326が1個と

Triton X-102(1.35 mL 6本)のセット

洗浄 10% Triton X-102 (50mL) Agilent 5185-5975 指定
GE Wash Packをご購入の場合は添

付で納品されます

洗浄
Stabilization and Drying Solution

(500ml)
Agilent 5185-5979 推奨 250ml程度；

実験室に高濃度のオゾンが存在する
場合のみ必要。オゾンフリーブースが
設置してある場合は必要ありません。

洗浄 Acetonitrile, anhydrous 99.8%, 1 L Sigma-Aldrich 271004 推奨 250ml程度
2色法でStabilization and Drying

solutionを使う際は、必要です。
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4．実験に必要な機器・器具 

 

 

用途 品名　（アレイフォーマット） 製造メーカー 品番
指定/
推奨/
相当品

必要量 備考

ラベル化 50mlコニカルチューブ（滅菌） 相当

ラベル化 ピペットチップ 相当
RNase Freeの物をお使いください。

オートクレーブ処理はお勧めしません。

ラベル化 UV分光光度計 NanoDrop ND-1000 相当

ラベル化 卓上遠心器 日本ミリポア チビタンII 相当

ラベル化＆
ハイブリ

パウダーフリー手袋
SAFE SKIN グローブ
PRE (S, M, L サイズ)

Kimberly・Clark
220, 330, 440

(S, M, Lサイズ)
相当

ラベル化＆
ハイブリ

ピペット（1ul-1ml) 相当

ラベル化＆
ハイブリ

1.5mlエッペンチューブ 相当
RNase Freeの物をお使いください。

オートクレーブ処理はお勧めしません。

ラベル化＆
ハイブリ

ヒートブロック（ラベル化65℃，

70℃）
ｴｯﾍﾟﾝﾄﾞﾙﾌ

ｻｰﾓﾐｷｻｰｺﾝﾌｫｰﾄ
5355-000-011

相当

ラベル化＆
ハイブリ

ウォータバス
（ラベル化４0℃、断片化60℃）

相当

ラベル化＆
ハイブリ

アイスバケツ

ラベル化＆
ハイブリ

高速遠心機 相当

ラベル化＆
ハイブリ

ボルテックスミキサー 相当

ハイブリ
オリゴDNAマイクロアレイ用
ハイブリダイゼーションチャンバ

Agilent G2534A 指定 消耗品が別途必要です。

ハイブリ
244K フォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60003 指定 5枚セット

ハイブリ
244K フォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60008 指定 20枚セット

ハイブリ
244K フォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60005 指定 100枚セット

ハイブリ
2x105Kフォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60002 指定 5枚セット

ハイブリ
2x105Kフォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60009 指定 20枚セット

ハイブリ
2x105Kフォーマット用消耗品

(ガスケットスライド)
Agilent G2534-60006 指定 100枚セット

ハイブリ
4x44Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60011 指定 5枚セット

ハイブリ
4x44Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60012 指定 20枚セット

ハイブリ
4x44Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60013 指定 100枚セット

ハイブリ
8x15Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60014 指定 5枚セット

ハイブリ
8x15Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60015 指定 20枚セット

ハイブリ
8x15Kフォーマット用消耗品

（ガスケットスライド）
Agilent G2534-60016 指定 100枚セット

ハイブリ ハイブリダイゼーションオーブン Agilent G2545A 指定 1台
別途専用ローターが必要です。
（下記）

ハイブリ
ハイブリダイゼーションオーブン
ローター

Agilent G2530-60029 指定 1個
最大24チャンバーまで載せることができ

ます。

ハイブリ ハイブリエイド
アジレントにお問
い合わせください

HYB-100 1セット

オプションとして使用できます。ハイブリ
ダイゼーションの際、マイクロアレイスラ
イドをガスケットスライドに乗せる作業を
補助する器具です。ハイブリダイゼーショ
ン作業を安定して行うことが出来ます。
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用途 品名 製造メーカー 品番

指定/推

奨/相当

品

必要量 備考

洗浄
クリーンガード
ブルーニトリルグローブ

Kimberly・Clark

57371,

57372,

57373

 (S, M, Lサイズ）

相当

事前にビーカーに入れたWash buffer1
で手袋を洗い、手袋から垂れるbufferが
白濁していないこと、ビーカー内のbuffer
に微粒子がないことを確認してください。
二トリルグローブと超精密ピンセット33A
のどちらかをアレイの洗浄ステップで使
用することをお勧めします。

洗浄 密閉容器 相当 1個
洗浄バッファ2を37℃に保温するのに使
います。

洗浄
スライド洗浄ガラス容器（Dish)（中 ）
Pyrex容器でも可

Wheaton 900301 相当
１個
(1セット3個入りです)

ガスケットスライドとマイクロアレイスライ
ドを解体するときに使います。
Wheaton900201やPyrexも使用可能で
すが、作業しやすくするため、
Weaton900201や小さい容器を使う場合
は超精密ピンセット33Aも合わせて使用
することをお勧めします。

洗浄 スライドラック　小　(ステンレス製)
Thermo

Shandon
109 相当 １個

ガラス容器900201（Wheaton）または
102（Thermo Shandon)を使用してくださ
い。最大洗浄枚数は5枚です。

洗浄 スライド洗浄ガラス容器（Dish)（小 ） Wheaton 900201 相当
2個あるいは4個

(1セット3個入りです)

スライドラック109（Thermo Shandon)に
対応しています。Wash buffer1, 2 (およ
びアセトニトリル, S&D溶液)に各1個ずつ
使用します。

洗浄 スライド洗浄ガラス容器（Dish)
Thermo

Shandon
102 相当

2個あるいは4個
（１個単位での販売で
す）

スライドラック109（Thermo Shandon)に
対応しています。Wash buffer1, 2 (およ
びアセトニトリル, S&D溶液)に各1個ずつ
使用します。

洗浄 スライドラック　中　(ステンレス製)
Thermo

Shandon
113 相当 1個

ガラス容器122に対応するサイズです。
最大洗浄枚数は8枚です。

洗浄 スライド洗浄ガラス容器（Dish)　(中）
Thermo

Shandon
122 相当

2個あるいは4個
（１個単位での販売で
す）

スライドラックは113(Thermoshandon)を
使用してください。 Wash buffer1, 2 (お
よびアセトニトリル, S&D溶液)に各1個ず
つ使用します。

洗浄 スターラー 相当 1台または2台

洗浄 恒温槽付スターラー 相当 1台

洗浄 回転子 相当 2個あるいは4個
小Dishには3cm、大Dishには4.5cm程

度のもの

洗浄 漏斗 相当 １個

洗浄
500mLの褐色または透明なガラス
瓶

相当 １個

洗浄 フラットピンセット 33A アズワン 7-160-13 相当 2個
マイクロアレイの洗浄ステップで二トリル
グローブと超精密ピンセット33Aのどちら
かを使用することをお勧めします。

洗浄
および

スキャン
オゾンフリーブース アズワン 2-M005-01B 推奨 1台

洗浄およびスキャン時のオゾンによる蛍
光色素の褪色を防ぎます。2色法の実験
には必須です。

スキャン
ウェハーガードGNガスフィルターガ
ン

日本インテグリス
株式会社

WGGB01KAG 推奨 1台

窒素ガスボンベに装着して使用します。
スライドガラスに付着したほこりを除く(ブ
ロワーで代用可能)、あるいは窒素パー
ジしてスライドグラスを保存する際に使
用します。フィルターガンのほかに、フィ
ルターおよびスパイラルチューブが必要
です。

スキャン オゾンバリアカバー Agilent G2505-60550 推奨

スキャン時のオゾンによる蛍光色素の
褪色を軽減します。アジレントアレイおよ
びアジレントスキャナの組み合わせで使
用可能です。

アレイの保存 スーパードライ　小型 SAYNSYO
59-0090

(2段タイプ)
相当 1台

パッケージ開封後のマイクロアレイや使
用済みのマイクロアレイの保存用デシ
ケータです。1段タイプ(59-0089)もありま
す。

スターラーおよび恒温槽付スターラーが
1台ずつ必要です。恒温槽付スターラー

がない場合は、スターラーは2台必要で

す。

アセトニトリルおよび S&D溶液は数回

繰り返し使うことが出来ます。使用済み
のアセトニトリルおよびS&D溶液を保存

するために使用します。

《参考商品》

《スライドグラス解体用》

《一回の洗浄が5枚以下の場合：必要なものを組み合わせて購入ください》

《一回の洗浄が8枚以下の場合：必要なものを組み合わせて購入ください》

《その他洗浄に必要な器具》
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＊ 洗浄用ガラス容器の必要数について 

１色法ではスライド解体用に 1 個、Wash1 と 2 用に各 1 個ずつ（解体用含めて計 3 個）、2 色法で S&D

溶液を使用する場合は、アセトニトリル用も含めさらに 2 個(解体用含めて計 5 個)必要です。 

＊ 洗浄用ガラス容器のサイズについて 

１回の洗浄がスライドグラス５枚以下なら小、５から８枚なら中を選択します。 

 

 

【試薬・消耗品の保証期間について】 

 アジレントマイクロアレイおよびその他のアジレント製品の保証期間は、箱やチューブの入った小袋

あるいはボトルに記載の Expiration date(Exp. date)までです。保証期間を過ぎた製品については欠

品等があった場合も交換ができない場合がありますので、製品が納品されたらすぐに内容物を確

認して下さい。 

 保証期間を過ぎると性能の保証ができないため、保証期間内に使用するように計画して下さい。 
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5．実習を始める前に 

 

 弊社内では、ネームプレートを着用いただきますよう、お願い申し上げます。 

 実験室内では、飲食、タバコは禁止されております。 

 応接室にあるコーヒー等はご自由にご利用ください。 

 喫煙は、喫煙コーナーでお願いいたします。 

 携帯電話は、他のお客様のご迷惑にならないようにご使用ください。 

（原則、マナーモードでのご使用をお願い致します） 

 

 

 必ず白衣、手袋、必要に応じてマスク、眼鏡をご着用ください。 

 スライドグラスの縁は鋭利です。手袋をはめ、十分注意して取り扱ってください。 

 Cyanine 3-CTP は発癌性物質を含んでいます。吸引、誤飲、皮膚への直接の接触は避けてくだ

さい。 

 Cyanine 3-CTP は光で分解します。出来る限り光にあたらないように注意して使用してください。

保管時，反応時は必ず遮光してください。 

 RNase のコンタミネーションを防ぐために、実験中はパウダーフリーの手袋を着用し、ヌクレアー

ゼフリーの溶液およびピペットチップを使用してください。 

 本実験では、毒性のある試薬を使用します。操作時の安全には、十分ご注意ください。 

 ハイブリダイゼーションバッファには塩化リチウム(LiCl)が含まれています。 

塩化リチウム(LiCl)には中枢神経系への毒性があります。 

催奇性があり、乳児に悪影響を与える可能性があります。 

不妊を誘発する可能性があります。 

吸入、皮膚接触、誤飲により、害を引き起こします。必ず適切な白衣、手袋、マスク、防護めがね

等を着用してください。 

 ハイブリダイゼーションバッファにはラウリル硫酸リチウム(LLS)が含まれています。 

ラウリル硫酸リチウム(LLS)は毒性があり、目、気管器系、皮膚に炎症を起こす可能性があります。

必ず適切な白衣、手袋、マスク、防護めがね等を着用してください。 

 ハイブリダイゼーションバッファには Triton が含まれています。誤飲により害を引き起こします。ま

た、目に入った場合深刻なダメージを与えます。 

 Agilent Stabilization and Drying Solution (cat. No. 5185-5979)は、毒性、引火性があります。

必ず、適切なヒュームフード（ドラフト）内で使用して下さい。また、有機溶媒を含んでいますので、

HPLC 廃液およびフェノール廃液と同様な廃棄処理を行ってください。 

 アセトニトリルは引火性と揮発性があります。吸引、皮膚接触、誤飲により肝臓、腎臓、循環器、

中枢神経系害を引き起こします。 

 実験に使用する全ての試薬・消耗品のロット番号と Expiration Date を記録して下さい。お

問い合わせ頂く際はこれらの情報を添えて、お問い合わせ下さい。 
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6．プロトコルの全体図 

 

 

 

 

 

Total RNA 
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ラベル化ステップのタイムテーブル 

 

Step Temperature  Time 

cDNA合成 155 min 

プライマーとテンプレートの熱変性 65ºC 10 min 

急冷 氷上 5 min 

二本鎖cDNA合成 40ºC 120 min 

逆転写酵素の失活 65ºC 15 min 

急冷 氷上 5 min 

cRNA合成 120 min 

cRNA合成 40ºC 120 min 

cRNA精製 30 min 

cRNA精製 RT 30 min 

 

 

 

 

 

実習の概要 

 

 本日の実習はオリゴ DNA マイクロアレイを 4 サンプルで１枚ご使用いただきます。 

 １名で１種類の total RNA サンプルをラベル化していただきます。 

 ご自分のサンプルが決まったら、ノートに明記いただくようお願いいたします。 

 予備のマイクロアレイ、サンプルは準備されておりません。何卒ご了解ください。 
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7．実験の操作手順 

 

１日目：実験の前準備 

 

 実験を始める前に、以下のものを準備してください。 

 マイクロピペッター（RNA 用） 1-10 uL,10-100 uL,100-1000 uL の３本 

 ピペットチップ（RNA 用） 上記各サイズ対応 

 チューブ立て 

 1.5 mL チューブ（RNaseFree） 

 アイスボックス  

※ 反応には、Cyanine 3-CTP (10 mM)を 2.4 uL 使用します。事前に反応数を確認し、十

分な Cyanine Dye が手元にあるようにします。 

 ヌクレアーゼフリー水 

 96-100％ エタノール 

 タイマー 

 Vortex ミキサー 

 パーソナル遠心機(スピンダウン用) 

 油性ペン 

 

 あらかじめ使用する機器の温度設定をしておきます。 

 ウォーターバスを 37℃、40℃に設定。cRNA 増幅＆ラベル化反応後 60℃に設定 

 ヒーティングブロックを 65℃、80℃に設定 

 

  

37℃
Spike-Mixの溶解 (5min)

65℃
T7 Promoter Primer の
アニーリング (10min)

40℃
cDNA合成反応 (2hr)

PEGの溶解 (1min)

40℃
ラベル化cRNA合成反応 (2hr)

65℃ または 70℃
熱変性 (65℃ 4分 または 70℃ 2分)

80℃
5X First Strand Bufferの溶解 (3 - 4min)

65℃
cDNA合成反応停止 (15min)

60℃
フラグメンテーション反応 (30min)

8-2. cDNA 合成反応（２ｈｒ）

8-3. cRNA 増幅＆ラベル化（２ｈｒ）

8-2. RNA テンプレートへの
T7 Promoter Primer のアニーリング

8-1. Spike-Mix の調製

8-4. Cyanine3-ラベル化 cRNA の精製

(8-5. バイオアナライザによる
ラベル化cRNAの品質チェック）

8-9-2. ハイブリダイゼーションの準備

（フラグメンテーション）

37℃
Spike-Mixの溶解 (5min)

65℃
T7 Promoter Primer の
アニーリング (10min)

40℃
cDNA合成反応 (2hr)

PEGの溶解 (1min)

40℃
ラベル化cRNA合成反応 (2hr)

65℃ または 70℃
熱変性 (65℃ 4分 または 70℃ 2分)

80℃
5X First Strand Bufferの溶解 (3 - 4min)

65℃
cDNA合成反応停止 (15min)

60℃
フラグメンテーション反応 (30min)

8-2. cDNA 合成反応（２ｈｒ）

8-3. cRNA 増幅＆ラベル化（２ｈｒ）

8-2. RNA テンプレートへの
T7 Promoter Primer のアニーリング

8-1. Spike-Mix の調製

8-4. Cyanine3-ラベル化 cRNA の精製

(8-5. バイオアナライザによる
ラベル化cRNAの品質チェック）

8-9-2. ハイブリダイゼーションの準備

（フラグメンテーション）
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8．実験：１日目 

（必ずプロトコルを参照ください。） 

 

8-1. One-Color Spike-Mix の調製（オプション） 

 ラベル化に用いる出発 RNA 量によって、Spike-Mix の希釈率と加える量が変わります。 

実験に使用するトータル RNA は、    ng です。下記の表を参照すると、今回の希釈手順は、 

それぞれ、以下の通りになります。 

 

 

※ 37℃、5 分間の加温を行い、Spike-Mix （原液）を溶かします。ボルテックスで混合し、スピンダウンし

てチューブの蓋、壁に付いた液を集めます。 

 

1st : 2 uL の Spike-Mix に 38 uL の Dilution Buffer を加えます（1:20） 

ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。  

2nd : 2 uL の 1st 希釈液に 48 uL の Dilution Buffer を加えます（1:25） 

ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

3rd : ___uL の 2nd 希釈液に___uL の Dilution Buffer を加えます（1:    ） 

ボルテックスで混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。 

 

注意 Spike-in 量の精度を確保するため、Spike-Mix を調製する場合は、2 uL 以上の量を扱うように

してください。 

 

※ 調製した 1st 希釈液は、‐70 ～ ‐80℃で約 2 ヶ月まで保存できます。さらに、8 回までの凍結融解を

繰り返すことが可能です。2nd 希釈液と 3rd 希釈液は凍結融解して再使用することができないので、

実験の都度調製してください。 

  

出発 RNA 量 希釈手順 3rdSpike- Mix の必要量(uL) 

トータル RNA (ng)  RNA サンプルの 1st  2nd 3rd 

 最大添加可能量 

200 8.3 1:20 1:25 1:10 2 

300 7.3 1:20 1:25 1:10 3 

400 6.3 1:20 1:25 1:10 4 

500 5.3 1:20 1:25 1:10 5 

600 7.3 1:20 1:25 1:5 3 

700 6.8 1:20 1:25 1:5 3.5 

800 6.3 1:20 1:25 1:5 4 

900 5.8 1:20 1:25 1:5 4.5 

1000 5.3 1:20 1:25 1:5 5 
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8-2. トータル RNA からの cDNA 合成 

 

Agilent's Quick Amp Labeling Kit は、200 ng から 1000ng の範囲のトータル RNA または、10 ng 以上

の poly A+ RNA からラベル化 cRNA を合成することができます。スタート RNA 量は一連の実験系では

揃えることをお勧めします。本キットでは、T7 RNA ポリメラーゼを利用して、ターゲットの増幅と同時に

Cyanine 3-CTP の取り込みも行います。通常 100 倍以上増幅されます。 

 

 反応チューブにサンプル名を書いてください。 

 必要なRNA 量、Spike-Mix の量、水の量は、スタート RNA 量と RNA の濃度によって異なります。 

 

1. 下記の表を参照して、T7 Promoter Primer Mix を調製してください。 

 

 

 

 

 

 

 

 

 

 

 

2. ６５℃で１０分 インキュベーション （熱変性） 

3. 氷で急冷、そのまま５分間冷却 

 

※ ここで使用する水は、必ず Invitrogen 社の DNase/RNase-free water (10977015) をお使いください。

DEPC 処理水を使用した場合、この後の反応を阻害する恐れがあります。 

トータル RNA 最大 RNA サンプル量 Spike-Mix 3rd 希釈液 T7 Promoter トータルボリューム 

(ng) (uL) 添加量 (uL) primer (uL)  (uL) 

200 8.3 2 1.2 11.5 

300 7.3 3 1.2 11.5 

400 6.3 4 1.2 11.5 

500 5.3 5 1.2 11.5 

600 7.3 3 1.2 11.5 

700 6.8 3.5 1.2 11.5 

800 6.3 4 1.2 11.5 

900 5.8 4.5 1.2 11.5 

1000 5.3 5 1.2 11.5 
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一反応分の
必要量(uL)

2.2反応分
(uL)

　5x First Strand Buffer(Pre-Warm, 80℃) 4 8.8
　0.1M DTT 2 4.4
　10mM dNTP mix 1 2.2
　MMLV-RT(反応開始直前に加える) 1 2.2
　RNase Inhibitor(反応開始直前に加える） 0.5 1.1
　トータル量 8.5 18.7

4． 使用する直前に、下記リストの順で試薬を加えてcDNAマスターミックスを調製します。通常の実験で

は必要量をまとめて調製しますが、今回は実習のため、お二人ずつ作製していただきます（2.2 反応

分作製します）。 

MMLV-RT と RNase Inhibitor は氷上に置き、反応開始直前まで加えないでください。 

 

注意 5X First Strand Buffer は事前に80℃のウォーターバスで３－4分間温めます。ボルテック

スでよく混合し、スピンダウンしてチューブの蓋、壁に付いた液を集めます。使用するまで室

温で置いておきます（氷上に置くと、析出する場合があります）。 

 

注意 ここの反応ではNTP mixではなく、10mM dNTP mixを使うので、必ずラベルを確認してくだ

さい。 

 

 

 

反応開始直前に酵素を加えることを忘れないようにしてください。 

cDNA マスターミックスは使用するまで室温に置いておきます。 

 

 

5. 各反応チューブ（RNA サンプルが入ったチューブ）に 8.5 uL の cDNA ミックスを加えます。ピペッティ

ングで溶液を混合します。 

 

 

 

 

 

 

 

 

 

 

 

 

6. ４０℃のウォーターバスで、２時間インキュベーションします。 

cDNA合成反応

ミックス

8.5 ul

cDNA合成反応

ミックス

8.5 ul
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8-3. Cyanine3-ラベル化 cRNA の合成 

 

1. チューブをウォーターバスから取り出し、６５℃１５分間インキュベーションし、反応を停止します。 

2. チューブを氷で急冷し、5 分間冷却します。 

 

3. 使用する直前に、下記リストの順で試薬を加えて、Transcription Master Mix を調製します。ただし、

酵素と色素は反応を開始する直前まで混合しないで下さい。 また、通常の実験では必要量をまとめ

て調製しますが、今回は実習のため、お二人ずつ作製していただきます（2.2 反応分作製します）。 

 

注意 使用前に50% PEGを40℃のウォーターバスで1分間温めます。ボルテックスでよく混合し、ス

ピンダウンしてチューブの蓋や壁についた液を集めます。 

使用するまで室温で置いておきます。 

 

下記リストの5番目までを1.5 mLチューブに加えます。ボルテックスでしっかり混合した後、スピンダウ

ンしてください。酵素と色素を加えるまで室温で置いておきます。 

反応開始直前に残りの試薬をリスト順に加え、ピペッティングで穏やかに混合します。 

 

注意 Cyanine 3-CTP (10mM) または Cyanine 5-CTP (10mM) はスキャン後の蛍光の色と、色

素自身の色が異なりますので、十分に注意してください。 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

一反応分の
必要量(uL)

2.2反応分
(uL)

　Nuclease-free water 15.3 33.66

　4x Transcription Buffer 20 44

　0.1M DTT 6 13.2

　NTP mix 8 17.6

　50% PEG (Pre-warm, 40℃) 6.4 14.08

　RＮase Inhibitor(反応開始直前に加える) 0.5 1.1

　Inorganic Pyrophosphatase(反応開始直前に加える) 0.6 1.32

　T7 RNA Polymerase(反応開始直前に加える) 0.8 1.76

  Cyanine 3 -CTP(反応開始直前に加える) 2.4 5.28

　トータル量 60 132
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4. 各反応チューブに、60 uL の Transcription ミックスを加えます。 

 

 

 

 

 

 

5. ４０℃のウォーターバスで、２時間インキュベーションします。 

チューブにアルミフォイルをかぶせ、遮光することをお奨めします。 

 

 

 

 

 

 

 

 

 

 

 

ハイブリダイゼーションを引き続き当日中に行う場合には、インキュベーション終了後、以下の設定をし

ておきます。 

 ウォーターバスまたはヒートブロックを60℃に設定 

 ハイブリダイゼーションオーブンを65℃に設定(ローターを取り付けておきます)。 

 オーブン庫内が表示温度で安定するまでに1時間~1時間半かかります。 

 

Cy3Cy3

アルミフォイルで遮光アルミフォイルで遮光

Cy3Cy3

60 ul

Cyanine3

Transcription
mix

Cy3Cy3Cy3Cy3Cy3

60 ul

Cyanine3

Transcription
mix
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8-4. Cyanine3-ラベル化 cRNA の精製 

 

 Qiagen社のRNeasyを使ってラベル化cRNAを精製します。ラベル化の際に取り込まれなかっ

たラベル化ヌクレオチド（モノマー）が、ハイブリダイゼーション液中に存在すると、マイ

クロアレイのバックグランドの蛍光が著しく高くなります。以下に記載してある手順に従っ

て実験を進めてください(Qiagen社のプロトコルを一部変更してあります)。 

 

 使用前に、RPEバッファにエタノール(96-100%)を必要量加えてください。RPEバッファは

次のページの洗浄ステップで使用します。調製が終わりましたら、フタのラベルのethanolの項目

にチェックマークを付けてください。 

 全ての遠心のステップは、13,000rpm(10,000g)以上の回転数で行ってください。 

 遠心を4℃で行うことにより、cRNAの収率があがることが確認されております。以下の遠心ステップ

を4℃で行うことを強くお奨めします。 

 RLTバッファにβ-メルカプトエタノール(β-ME)を加える必要はありません（β-MEが入っていても問

題ありません）。 

 

1. 20 uLのヌクレアーゼフリー水をcRNAサンプルに加え、液量を100 uLにします。 

 

 

 

 

 

 

 

 

2. 350 uLのRLTバッファを加え、混合します。 

3. 250 uLのエタノール( 純度96-100%)を加え、ピペットで混合します。スピンダウンを含め遠心は 

しないでください。 

4. 700 uLのcRNAサンプルを2 mLのコレクションチューブをつけたRNeasy miniカラムに移します。カ

ラムチューブを13,000 rpmで30秒間遠心します。カラムを素通りした液は捨てます。 
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5. RNeasyカラムを新しいコレクションチューブに移し、500 uLの調製済みのRPEバッファ(エタノール

を加えたもの)をカラムに加えます。カラムチューブを13,000 rpmで30秒間遠心します。カラムを素

通りした液は捨てます。 

 

 

 

 

 

 

 

 

 

6. コレクションチューブはそのまま使用し、再度500 uLのRPEバッファをカラムに加えます。カラムチュ

ーブを13,000 rpmで1分間遠心します。カラムを素通りした液は捨てます。 

もしカラムのフリットにRPEバッファが残っていれば、カラムを新しい1.5mLチューブに移し、 

13,000 rpmで30秒間遠心し、残っているRPEバッファを完全に取り除きます 

 

7. RNeasyカラムを新しい1.5 mLチューブに移します。 

 

8. 30 uLのRNase-free水をカラムのフィルター中央に加え、1分間おきます。カラムチューブを13,000 

rpmで30秒間遠心します。カラムを通った液はそのまま残します (液を捨てないように注意してくだ

さい) 。 

 

9. チューブは氷上においておきます。使用済みのカラムは捨てます。回収したcRNAの濃度、収量お

よび品質をUV計とバイオアナライザを用いて確認します (次ページ参照) 。 
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8-5. ラベル化 cRNA の分析 

通常500 ngのトータルRNAからスタートした場合、2.0 – 4.0 ugのcRNAを合成できますが、トータルRNAの

純度や質(分解度)によっても異なります。合成したcRNA量は、通常のキュベットを使った分光光度計で

測定するには少なすぎる場合がほとんどです。濃度決定に使用するRNA量を最小限に抑えるために、

本プロトコルではNanoDrop分光光度計を推奨しています。 

 

 NanoDrop のソフトウェアを起動し、”Microarray Measurement”のタブを選択します。Sample Type

は RNA-40 と選択します。 

 1.5 uL のヌクレアーゼフリー水で、NanoDrop でブランクを設定します。 

 1.5 uL の増幅 (ラベル化) cRNA を測定し、A260 と A550 を記録します。 

 

（1） NanoDrop 計測結果より、cRNA濃度 （ng/uL）を記録します。 

 RNA濃度が自動算出されない分光光度計をご使用の場合、A260の値から以下の式で算出して下さい。 

cRNA conc. (ng/uL) * = A260 x 40 ug/mL x dilution factor** 

 *光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

 **希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

（2） (1) のcRNA濃度（ng/uL）に溶出量（使用した精製キットにより30 ul あるいは20 ul） 

を乗じ、以下の式でcRNA収量を算出します。 

cRNA yield(ug) = cRNA conc(ng/uL) × 30(uL) / 1000  

 

（3） NanoDrop 計測結果より、Cy3色素の濃度 (pmol/ul)を記録します。 

色素濃度が自動算出されない分光光度計をご使用の場合、A550の値から以下の式で算出して下さい。 

Cy3-CTP conc (pmol/ul) * = A550 x 1000 ÷ 150 mM-1cm-1 x dilution factor** 

*光路長10 mmの測定器を使用した場合の式です。ご使用の機器の光路長をご確認下さい。 

**希釈せずに濃度を測定した場合は、Dilution Factorは1を用います。 

 

（4） 以下の式で、Cy3色素の取込率を算出します。 

 

 

 

 

※ 通常cRNAの溶出量は1.65 ug以上、CyDyeの取り込み効率は9 pmol/ug以上が期待されます。 

それ以下の場合には、再度cRNAの調製をされる事をお勧めいたします。 

 

・測定した濃度から、マイクロアレイへのハイブリダイゼーションに必要な cRNA 量を計算します。 

アレイフォーマットによって必要量が異なるのでご注意ください(P.26 参照)。 

Cy3-CTP incorporation ( pmol/ug) =
Cy3-CTP conc. ( pmol/ul) x1000

cRNA conc. ( ng/ul)
Cy3-CTP incorporation ( pmol/ug) =

Cy3-CTP conc. ( pmol/ul) x1000

cRNA conc. ( ng/ul)

Cy3-CTP conc. ( pmol/ul) x1000

cRNA conc. ( ng/ul)
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バイオアナライザによる品質チェックを行います。 

 1.5 mL エッペンチューブに 1.5 uL のラベル化 cRNA を移します。 熱変性（70℃2 分）を行い、氷

上に置きます。 1 uL をバイオアナライザの測定に供します。 

 バイオアナライザでラベル化 cRNA を泳動する際は、mRNA assay を選択します。 

 

 

バイオアナライザのエレクトロフェログラムから cRNA の質を確認します。 

 

 

 

バイオアナライザの分析例 

 

 

ラベル化サンプルのシグナルの大部分が、200 から 2000 塩基長のサイズ範囲に位置しているかを確認

して下さい。これ以外の領域にピークの大部分がある場合、正確なデータが出ない可能性があります。 

データ分析時に、ツールバーのアイコン をクリックすると、横軸の表示を秒あるいは nt に切り替

えられます。 

 

ラベル化 cRNA の保存 

cRNA を直ぐに使用しない場合には、少量に分注し、暗所－80℃で保存します。 

長期保存の場合は、チューブに 1 回分の分量を分注して保存して下さい。 

 

サンプルの冷凍、解凍のサイクルを繰り返すと cRNA が分解しやすくなります。保管している cRNA の質

がわからない時は、Agilent 2100 バイオアナライザおよび UV 計で再度品質を確認することをお勧めし

ます。 
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8-6．ハイブリダイゼーションの準備 

 

 増幅反応を行っている間に、次のものを準備してください。 

 アジレント オリゴ DNA マイクロアレイ  

 オリゴ DNA マイクロアレイ用 ハイブリダイゼーションチャンバ 

 チャンバ消耗品 (ガスケットスライド) 

 ピンセット（清潔なもの） 

 パウダーフリー手袋  

 マイクロピペッター（RNA 用） 1-10uL,10-100uL,100-1000uL の３本 

 ピペットチップ（RNA 用） 上記各サイズ対応 

 1.5 mL エッペンチューブ（滅菌済ヌクレアーゼフリー） 

 チューブ立て（RNA 用） 

 高速遠心機 

 ボルテックスミキサー 

 アイスボックス 

 タイマー 

 ヒートブロック、またはウォーターバス（60℃） 

 ハイブリダイゼーションオーブン（65℃） 

 アジレントチャンバ用ハイブリダーゼーションローター 

 

 使用する機器の温度設定を確認しておきます。 

 ウォーターバスまたはヒートブロックを 60℃に設定 （増幅反応終了後に変更します。） 

 ハイブリダーゼーションオーブンを 65℃に設定（ローターを取り付けておきます） 

オーブン庫内が表示温度で安定するまでに1時間~1時間半かかります。早めに設定を 

しておいて下さい。 
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8-7. ハイブリダイゼーションチャンバの種類 

 

注意 本チャンバはアジレントのオリゴ DNA マイクロアレイ専用です。 

 

 

 

 

 

 

 

 

ｱﾚｲ ﾌｫｰﾏｯﾄ 8x15K 4x44K 2x105K 244K

ﾊｲﾌ ﾘ゙ﾀ ｲ゙ｾ ﾞー ｼｮﾝ
液量 (1ｱﾚｲあたり）

40uL 100uL 245uL 490uL

ｶ ｽ゙ ｹｯﾄｽ ﾗｲﾄﾞ
G2534-60014

(8ｱﾚｲ
   x 5ｽﾗｲﾄ 分゙）

G2534-60011

(4ｱﾚｲ
   x 5ｽﾗｲﾄ 分゙）

G2534-60002

(2ｱﾚｲ
   x 5ｽﾗｲﾄ 分゙)

G2534-60003

(5ｽﾗｲﾄ 分゙)

ﾁｬﾝﾊ ﾞー

ﾊ ｲﾌ ﾘ゙ﾀ ｲ゙ｾ ﾞー ｼｮﾝ
ﾊ ｯ゙ﾌｧの種類

(8x15K、4x44K、2x105K、244K)

2x HI-RPM

G2534A

ﾊｲﾌ ﾘ゙ﾀ ｲ゙ｾ ﾞー ｼｮﾝ
回転速度

(8x15K、4x44K、2x105K、244K)

10 rpm
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8-8. マイクロアレイの取り扱い上の注意 

 

1x244K タイプのアレイ：1 枚のスライドに 1 つのマイクロアレイ 

2x105K タイプのアレイ：1 枚のスライドに２つのマイクロアレイ 

4x44K タイプのアレイ：1 枚のスライドに４つのマイクロアレイ 

8x15K タイプのアレイ：1 枚のスライドに 8 つのマイクロアレイ 

がそれぞれ載っています。 

■ マイクロアレイはバーコードラベルに”Agilent”の文字が入っている面に載っています。Agilent の文

字が入っている面が Active サイド、数字だけのバーコードラベルが付いている面は Inactive サイドで

す。ハイブリダイゼーションを行う際は、アレイがプリントされている Active サイドに、必ず溶液をアプ

ライするように注意してください。 

■ 各オリゴ DNA マイクロアレイのレイアウトやサイズなどの詳細な情報については付録をご参照くださ

い。 

■ スライドグラスを取り扱う際は手袋をはめ、スライドグラスの縁を注意深く持って取り扱って下さい。ス

ライド表面には両側とも決して触らないで下さい。 

■ スライドグラスを取り扱う際は、必ずパウダーフリーの手袋を着用してください。 

■ ハイブリダイゼーション、洗浄のステップでアレイを乾燥させないように注意して下さい。 

■ ハイブリダイゼーションを行う前に、実験机を整理整頓して下さい。ハイブリダイゼーション器具の周

りはなるべく障害物がない状態を作ってから次ページ以降の操作を行って下さい。 

■ ハイブリダイゼーションは水平な実験台で行って下さい。下記ハイブリエイドをお持ちの場合は、内蔵

の水準器で水平が確認できます。ハイブリダイゼーション作業を始める前に、予めご確認ください。 

■ 手でアレイスライドをガスケットスライドに乗せるのが難しい場合、オプションとして、ハイブリエイドを

用いてアレイスライドを乗せることが出来ます。 

※ ハイブリエイドはハイブリダイゼーション作業を補助するオプションの器具です。 

8-9. ハイブリダーゼーション 

 

8-9-1. 10x Blocking Agent の準備 (必要時間 5 分) 

スピンダウンしてペレットをチューブの底に集めた後、ヌクレアーゼフリー水 0.5 mL を Blocking Agent に

加えます。軽くボルテックスをして、溶解させます。‐20℃で約 2 ヶ月まで保存できます。 

使用前に凍結した溶液を解かした時には、軽くボルテックスをして完全に溶解してください。 

※ Blocking Agent が完全に溶解しない場合は、37℃で 4-5 分温めて、完全に溶解させて下さい。 

※ Large volume キットをお使いの場合には、ヌクレアーゼフリー水 1.25 mL で溶解してください。 
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8-9-2. ハイブリダイゼーションサンプルの準備 （必要時間 45 分） 

1.5 mL のヌクレアーゼフリーチューブを準備します。下記に示した cRNA 量になるようにラベル化した

cRNA 溶液を調製し、1.5 mL エッペンチューブに入れます。原液、及びあまった希釈液は-80℃で保管し

ます。凍結融解を繰り返すと RNA の品質に悪影響を与えますのでご注意ください。 

1．下表に従い、Cy3 ラベル化 cRNA ターゲット、10x Blocking Agent、Nuclease-free water、25X 

Fragmentation Buffer を加え、緩やかにボルテックスをして、サンプルを十分に攪拌してください。

複数サンプルある場合は、全てのチューブにラベル化 cRNA、10x Blocking Agent および

Nuclease-free water を調製し、最後に Fragmentation Buffer を各チューブに添加してください。 

2. 60℃のウォーターバスまたはヒートブロックで３０分インキュベーションします。必ず遮光してください。

フラグメンテーションが30分を超えない事が重要です。 

3. 30分後、ただちにサンプルを氷水上に移し、1分間冷却します。その後速やかに、フラグメンテーショ

ンをストップさせるため、下表に従って2XGE Hybridization Buffer HI-RPMを加えます。 

各チューブはバッファを加えるまで氷上においておきます。 

注意 以前販売していた2x GE Hybridization Bufferと2x GE Hybridization Buffer HI-RPMは

別の試薬です。必ず2x GE Hybridization Buffer HI-RPMをご使用下さい。 

4. ピペットでゆっくりと液を混合させます。泡を立てないように十分に気をつけてください。高速でボル

テックスを行うと泡が発生しますので、ボルテックスは使用しないようにしてください 

5. 高速遠心機でスピンダウンして(13,000 rpm、1分、室温)、蓋や壁についた液を底に集めます。 

6. サンプルを氷上に置き、直ちにハイブリダイゼーションに使用してください。保存はできません。 

マイクロアレイ フォーマット 8x15K 4x44K 2x105K 1x244K

リニア増幅Cyanine 3

ラベル化 cRNA
0.6 ug 1.65 ug 1.5 ug 1.5 ug

10x Blocking Agent 5 uL 11 uL 25 uL 50 uL

ヌクリアーゼフリー水 適量 適量 適量 適量

25x Fragmentation Buffer 1 uL 2.2 uL 5 uL 10 uL

最終量 25 uL 55 uL 125 uL 250 uL

マイクロアレイフォーマット 8x15K 4X44K 2X105K 1X244K

フラグメンテーションの溶液量 25 uL 55 uL 125 uL 250 uL

2X G E Hybridization Buffer
HI-RPM

25 uL 55 uL 125 uL 250 uL

最終量
(1マイクロアレイあたり)

50 uL 110 uL 250 uL 500 uL
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8-10. ハイブリダイゼーションチャンバの組み立て 

 

ハイブリチャンバを組み立てるにあたり、以下のキットが必要になります。 

ハイブリダイゼーションチャンバ (G2534A) 

 

 

 

 

 

 

 

 

 

 

 

 

ハイブリダイセーション消耗品： 244K 用 (G2534-60003), 2x105K 用 (G2534-60002), 

4x44K 用(G2534-60011), 8x15K 用(G2534-60014) 

 

 

 

 

 

 

 

 

 

■ （オプション）ハイブリエイド 

 

 

 

  

チャンバ－ベ－ス

チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット

チャンバ－ベ－ス

チャンバ－カバ－チャンバ－カバ－

クランプ　　
アッセンブリ

スクリュー

ブリッジ

クランプ　　
アッセンブリ

スクリュー

ブリッジ

プラスチック製
ピンセット
プラスチック製
ピンセット

ガスケットスライドガスケットスライド
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1. ピンセットを使ってガスケットスライドのプラスチックカバーの端をつまみ、ゆっくりとはがします。ガス

ケットスライドをパッケージから取り出します。この時、スライドの縁以外には触れないようにしてくだ

さい。必ずパウダーフリーの手袋を着用してください。 

 

 

 

 

2. チャンバベースの上に、ガスケットスライドを”Agilent”の文字が書かれている面を上にして載せます。

ガスケットスライドは、ハイブリダイゼーション溶液を介して直接アレイに触れますので、ほこり等が

つかないようにすばやくセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

3. ガスケットスライドがしっかりとチャンバベースにセットされているか確認し、正しくされていない場合

は、再度セットし直してください。 

（オプションのハイブリエイドを用いる場合、 

ここで次々ページの【参考手法】を参照下さい） 

 

 

 

4. ハイブリダイゼーション溶液をガスケットスライド上にアプライします。アレイスライドのバーコード番

号およびアプライしたサンプル位置を記録しておきます。 

 

ハイブリダイゼーション溶液がガスケットのふちまで広がらないように、ガスケットの中央部分にアプ

ライしてください。スライドガラス上の全てのウェル間で、液面の高さが揃うように、ゆっくりと均等に

液を配置します。 

 

 

 

 

マイクロアレイ フォーマット
ハイブリダイゼーション　液量

（１アレイあたり）

8x15K 40 uL

4x44K 100 uL

2x105K 245 uL

1x244K 490 uL
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サンプルをアプライしないウェルがある場合、バーコードに近いウェルにサンプルをアプライし、数

値化に Feature Extraction 9.5 以降をお使いの場合、空白ウェルはバーコードから遠い位置にして

下さい。Feature Extraction 9.1 をお使いの場合、空白ウェルはスライド中央の 2 アレイに設定して

下さい。 

空白ウェルには、水で 1x の濃度に希釈をした GE Ｈｙｂｒｉｄｉｚａｔｉｏｎ Ｂｕｆｆｅｒ ＨI-ＲＰＭを、アレイのフ

ォーマットに応じて、上の表の量、アプライして下さい。 

（オプションのハイブリエイド用いる場合、ここで次ページの【参考手法】を参照下さい） 

5. アレイ面(Agilent と書かれているバーコード面) を下して(数字が書かれている方のバーコード面は

上に)、マイクロアレイスライドをチャンバベースにセットされているガスケットスライド上に載せます。

このとき、アレイスライドの縁またはバーコードシール部分を持つようにしてください。マイクロアレイ

スライドを水平に保ったままガスケットスライドにのせます。 

アレイを正しくセットした後、チャンバや重なっているスライドグラスを動かさないようにしてください。

ハイブリダイゼーション溶液が漏れる原因になります。 

 

注意 2 枚のスライドのバーコードが、正しい位置で重なり合うようにセットしてください。 

チャンバベースの 4 つの突起(図の矢印の部分)にしっかりはまるようにします。 

 

 

 

 

 

 

注意 1 スライドに複数のアレイが搭載されているタイプで、チャンバカバーをセットする前、

“サンプル溶液が接しているアレイ”と“接していないアレイ”があるように見える場合が

ありますが、問題ありません。アレイスライドを乗せた後は、位置の微調整などは行わず、

すぐチャンバカバーを乗せて下さい。 
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※参考手法 

ハイブリエイドを用いることにより、手作業では水平に降ろしづらいマイクロアレイスライドを、サンプルを

アプライしたガスケットスライド上に安定して乗せることが出来ます。 

使用器具： ハイブリエイド (HYB-100) 

 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

① ガスケットスライドにサンプルをアプライし終

わった時点でチャンバベースの両端から各

ハイブリエイドを差し込み、突き当たるまで動

かします。ガスケットスライドの端を、ハイブリ

エイドの突起部分が覆うような形となります。 

 

② アレイ面(Agilent と書かれているバーコード

面) を下にして(数字が書かれている方のバ

ーコード面は上に)、マイクロアレイスライドを

ハイブリエイド上に乗せます。アレイスライド

の縁またはバーコードシール部分を持つよう

にして下さい。バーコードシール側を先にハ

イブリエイドの上に置き、そこを押さえながら

もう片方をゆっくり下に倒すと作業が容易で

す。チャンバベースの 4 つの突起に当たらな

いように注意して下さい。この時、アレイスラ

イドはハイブリエイドに支えられてハイブリ液

には接していません。 

 

③ 左右のハイブリエイドを同時に引き抜いて下

さい。アレイスライドが水平に落ち、ガスケッ

トスライドと正しい位置で重なります。アレイ

スライドを乗せた後は、位置の微調整などは

行わず、すぐチャンバカバーを乗せて下さ

い。引き抜く先に障害物などが無いようにし

て下さい。 
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6. チャンバカバーを、チャンバベースの上にセットします。カバーの向きを間違えないように注意してく

ださい。 

 

7. クランプアッセンブリを、チャンバベースの丸くなっているコーナー側から差し込み、完全にストップす

る位置まで移動させます。ストップする位置は、ちょうどチャンバの中央部になります。 

 

 

 

 

 

 

チャンバが水平に保たれていることをご確認した後、手でスクリューをしっかり締めます。チャンバに

ダメージを与える可能性があるので、ペンチなどの道具は決して使用しないでください 

 

 

 

 

 

 

8. 組み立て終了後、チャンバを垂直方向にして 2,3 回、回転させて、ハイブリ溶液がスライドガスケット

の全面に行き渡るようにします。次に、チャンバ内の泡が自由に動くことができるか確認してください。

ハイブリ溶液が行き渡っていない部分や、固定している泡により、ハイブリむらが起きる場合があり

ますので、泡が動かない場合には、チャンバを手にもって振ることで、泡を移動させます。 

 

9. 残りのスライドも同様に、上記の作業を行ってください。 
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10. チャンバの組み立てがすべて終わりましたら、予め 65℃にセットしたオーブンのローターに差し込み

ます。ハイブリダイゼーション中に外れることがないように、両端をしっかりと差し込んで固定してくだ

さい。複数のスライドグラスをハイブリダイズするときは、必ずローターのバランスをとってチャンバを

セットするようにしてください。奇数枚の時は、スライドグラスなしでチャンバを組み立て、ローターの

対面にセットしてください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11. ハイブリダイゼーションオーブンの扉を閉め、回転数 10 rpm(8x15K、4x44K、2x105K、1x244K) 

に設定します。 

           

12. 65℃で 17 時間ハイブリダイゼーションさせます。 

Agilentハイブリダイゼーション 

オーブン (G2545A) 

ハイブリダイゼーション 

オーブンロータ 

(G2530-60029) 
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8-11. 洗浄の準備 

 

1.Triton X-102 の Gene Expression Wash Buffer への添加 

最終濃度 0.005%になるように、Triton X-102 を Gene Expression Wash Buffer1 と 2 に添加すること

で、マイクロアレイの洗浄におけるアーティファクトの可能性を軽減することができます。 

 

10% TritonX-102 は Gene Expression Wash Pack(5188-5327)に含まれています。単体でもご購入い

ただけます(50mL、5185-5975)。 

 

Gene Expression Wash Buffer 1 と 2 の開封時に、以下の方法で 10%Triton X-102 を加えます。 

この操作は、Wash Buffer１にも 2 にも行います。 

開封時に添加すれば、その後洗浄時に添加する必要はありません。 

 

1-1） ダンボール箱中の容器の、外蓋と中蓋を注意深く開ける 

1-2） ピペットで 2mＬの 10％ Triton X-102 を容器中の Wash Buffer に加える 

1-3） 中蓋・外蓋をきっちり戻し、5・6 回容器全体を転倒混和して、注意深くかつしっかり混ぜる。 

1-4) 中蓋・外蓋を外し、Buffer に添付の蛇口を取り付ける 

1-5) Wash Buffer の容器に『Triton X-102 添加済』と記載し、日付を記録する 

 

Gene Expression Wash Buffer 中の Triton X-102 の最終濃度が 0.005%になれば、開封済みのより少

ない量の Buffer にも添加することができます。 

 

2. Wash2 の保温 

洗浄前日から、Gene Expression 洗浄バッファ 2 とスライドグラス洗浄用ガラス容器(1 個)を 37℃で保

温しておきます。洗浄バッファ 2 を別容器に移して少量温める場合は、蒸発を防ぐため密閉容器を使用

してください。 

 

 

≪ガラス容器およびチャンバの洗浄法≫ 

洗浄に使用するガラス容器やラック、回転子等はマイクロアレイの洗浄専用にしてください。使用後は

洗剤を使わずに水洗いをしてください。洗剤が残っている器具を使用すると、マイクロアレイに洗剤が

付着し蛍光を発する場合があります。 

 

1. チャンバ、ガラス容器、回転子およびラックを水道水ですすぎます。汚れが気になる場合は、洗剤

がついていないスポンジでこすってください。 

2. 超純水でよくすすぎます。5 回ほどすすいでください。 

3. 埃がつかないように乾燥させます。 
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9．実験：２日目 

 

スライドグラス洗浄の前準備 

洗浄を始める前に、以下の機器・器具を準備してください。 

 スライドグラス洗浄用ガラス容器（中 3） 

 スライドラック(サーモエレクトロン 109) 

 スターラー（2） 

 回転子（ラック小（サーモエレクトロン 109）の場合 3.0cm 程度のもの 2 

ラック中（サーモエレクトロン 113）の場合 4.5cm 程度のもの 2） 

※ 回転子の大きさが十分でない場合、洗浄力が弱くなる恐れがあります。 

 タイマー 

 ピンセット 

 パウダーフリーの手袋 

パウダーフリーの表示があっても、蛍光を持つ粒子が手袋についている場合があります。事

前に、確実に手袋から微粒子が発生しないことをご確認ください。ビーカーに入れた Wash1

の溶液で手袋を事前に洗い、手袋から垂れる Wash 溶液が白濁していないこと、および手

袋をあらった後の、ビーカー内の溶液に微粒子がないことを確認してください。手袋から発生

する微粒子は、アレイの表面に吸着して結果に大きな影響を及ぼします（手袋から粒子が生

じる場合の解体方法は p.36 をご参考ください）。 

 

     

スライドグラスの洗浄操作 

 

1． 以下の洗浄バッファを用意します。 

A ： 洗浄バッファ 1: Agilent Gene Expression Wash Buffer 1 

B ： 洗浄バッファ 2: Agilent Gene Expression Wash Buffer 2 (37℃で保温してあるもの) 

37℃のウォーターバスまたはオーブンで溶液を加温します。洗浄直前時まで 37℃で保温して下さい。

弊社では、37℃で保温可能なスターラー付恒温槽（アズワン株式会社、品番：1-5088-01、写真参照）

の利用を推奨しております。 

 

 

Step ガラス容器 温度 時間 

チャンバ分解 1 RT 

洗浄バッファ1 2 RT 1min 

洗浄バッファ2 3 37℃ 1min 
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0 min 5 min

15 min 30 min

2． 下記の通り、3 つの洗浄用ガラス容器を準備します。 

 

注意 ハイブリダイゼーションチャンバの分解を始める前に、全ての必要な洗浄バッファとディッシュ

の準備を行って下さい。洗浄・乾燥のステップは、できるだけ効率的に行って下さい。 

注意 注意深く洗浄プロトコルに従ってください。また指定の器具を使用してください。洗浄時間を守

ることは非常に重要です。洗浄時間がプロトコルの時間から外れた場合には、結果がばらつい

てしまう場合があります。また、スライド洗浄を行う際の攪拌には、シェーカーを使わずに、必

ずマグネットスターラーを使用して下さい。 

 

ガラス容器 1 : 洗浄バッファ 1,  ガスケットの解体用 

ガラス容器 2 : 洗浄バッファ 1,  スライドラックと回転子を中に入れておきます 

ガラス容器 3 : 洗浄バッファ 2 (37℃に保温したもの), 回転子を中に入れておきます 

スターラー付恒温槽がある場合には、37℃に設定して、ガラス容器 3 をセットします

（写真参照）。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ１の洗浄を開始するまで、37℃で保温し

てある洗浄バッファ２を加えないで下さい。 

 

 

 

 

 

 

 

3. ハイブリオーブンからチャンバを取り出します。複数のアレイをハイブリダイゼーションしている場合も、

チャンバは必ず１つずつ取り出すようにしてください。泡が形成されているか、また泡が自由に動いて

いるか確認してください。 

 

注意 チャンバをオーブンから取り出し、室温で静置すると、放置時間に応じて、ハイブリ液の覆っ

ている部分と気泡の部分で、シグナル強度に差異を生じます（下図参照）。オーブンから取り出したチ

ャンバは、必ずすぐに解体

し、アレイスライドを Wash1

中のスライドラックに移すこ

とが重要です。また複数枚

のスライドを一度に wash す

る場合も、1 スライドずつ取

り出し、解体の直前まで、規

定の温度に保温されている

ことが重要です。 

 

スターラー付恒温槽 

室温放置の影響を検証したデータ 
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4. チャンバの分解 

a. チャンバを水平な台の上に置き、スクリューを逆時計回りにまわしてゆるめます。 

b. クランプアッセンブリを外し、チャンバカバーを取り除きます。 

c. 手袋をはめた手で、チャンバベースから重なっている 2 枚のスライドを同時に取り出します。この

時、スライドの両端をしっかり持つようにしてください。すぐに、アレイスライドを上にした状態で

(数字が書かれているバーコード面を上にして)、2 枚のスライドが重なっている状態でガラス容

器 1 内の洗浄バッファ 1 に浸けます。 

 

5. 2 枚のスライドが完全に洗浄バッファ 1 に浸かった状態で、スライドのバーコード側から 2 枚のスライ

ドを離します。 

a. ピンセットの先端を２枚のスライドの間に差し込み、ゆるやかに

ピンセットを上側または下側に回転させてスライド同士を離しま

す。 

b. ガスケットスライドのみを容器の底に落としてください。  

 

6. アレイスライドをすばやく取り出し、洗浄バッファ１を入れたガラス容器 2 にセットされているラックにそ

っと差し込みます。 

 

注意 スライドグラスを扱う時は、バーコード部分かスライドグラスの縁を持つようにします。決してマ

イクロアレイに触れることがないように注意してください。アレイが空気に触れる時間を最小限

に押さえてください。 

 

※参考手法 

ピンセットを用いることにより、洗浄液に手袋を浸さないでアレイを洗浄することができます。 

使用器具： 超精密ピンセット No.T (品番は p.9 参照)  

  

①2 枚のスライドをピンセットで挟み、 ②バーコード側のピンセットを ③両手でスライドガラスを 

 立てた状態でガラス容器１に入れる。 2 枚のスライドガラス間に入れ しっかりはさみ、 

 アレイ面を傷つけないように ガラス容器２中の 

  ガスケットスライドをはがす。 ラックに運ぶ。 

 

  1 2 3
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7. 残りのチャンバも同様に解体して、すべてのスライドをラックに差し込みます。一度に洗浄するアレイ

は 8 枚以下にするようにしてください。 

注意 スライドグラスをラックに差し込む際は、洗浄の効率を保つために端は 3 つ以上、スライドグラス

間は 2 つ以上空けてください。19 スライドラックは最大 5 枚、30 スライドラックは最大 8 枚洗浄

可能です。全てのスライドで、アレイ面がラックの中心を向く向きに揃えます。 

19 スライドラック(Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ109) 30 スライドラック（Ｔｈｅｒｍｏ Ｓｈａｎｄｏｎ113） 

 

 

 

 

 

 

 

 

 

 

8. 全てのアレイをスライドラックにセットできたら,中程度の回転速度で室温のまま１分間 攪拌します。 

注意 アレイスライドおよびスライドラックを入れた状態で、液面が波立つ程度の速さで攪拌してくだ

さい。スライドグラスの枚数、液量によって回転数は異なるので、その都度調節してください。

回転速度が十分でない場合、洗浄力が弱まる恐れがあります。 

注意 スターラー付恒温槽を利用しない場合、洗浄バッファ 1 でスライドガラスを洗浄している間に、

ガラス容器 3 に 37℃で保温してある洗浄バッファ２を注ぎます。 

9. スライドラックを 37℃の洗浄バッファ２（ガラス容器 3）にすばやく移します。中程度の回転速度（液面

が波立つ程度の速さ）で 1 分間 攪拌します。実験を成功させるために、この洗浄時間を厳守してく

ださい。 

10. 洗浄バッファ 2（ガラス容器 3）からスライドラックを取り出します。この時、スライドラックを平行に保

ち、スライド上に水滴が残らないように注意しながら、5-10 秒かけて引き上げてください。スライドラ

ックを溶液から出したり戻したりしないように注意して下さい。 

11. 10 の操作でスライドガラスは乾燥しますので、その後ただちにスキャンを行うことができます （窒素

ガスによる乾燥は必要ありません）。すぐにスキャンをしない場合には、窒素パージして暗所で保管

してください。必要でしたらスキャン後に、スライドグラスはポリプロピレンスライドボックスに入れ（コ

ルクなどの詰め物をしないでください）、真空デシケータまたは窒素パージボックスに入れて暗所で

保存します。真空デシケータの方が色素の退色が見られるため、窒素パージボックスをお勧めして

います。 

注意 アレイの洗浄は、オゾン濃度が 50ppb 以下の環境で行なってください。実験室内のオゾン濃度

が著しく高い場合には、弊社までご相談ください。 
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10. Agilent スキャナを用いたスキャニング 

レーザーを安定させるためにスキャンを開始する 20 分前までに、PC、スキャナおよび 

スキャナコントロールソフトをこの順に起動しておきます。 

 

1. スキャニングの準備 

1. スライドをスライドホルダにセットします。スライドホルダをカローセルにセットした際に、数字のバーコ

ード面が見えるような向きで挿入します。 

 

 

 

 

 

 

 

 

 

 

2. スライドホルダをスキャナのカローセルにセットします。 

 

2. スキャナコントロールソフト ver.7（B バージョンスキャナ）をお使いの場合 

1. 画面下の”Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、”Start slot”と”End slot”で指定します。 

3. 設定を変更するスライドをテーブル内で選択してください(複数枚選択できます)。選択されると青くハ

イライトされます。 

4. “eXtended Dynamic Range Scan Mode”にチェックを入れ、”Hi”を 100%に、”Lo”を 10%にしま

す。 

5. “Edit Slot Values>>”をクリックしてメイン画面を拡張します。 

 奥のつめにのせる 

アレイ面 

ラベルが手前、 

“Agilent”と記載の面 

がホルダの上側に 

くるように挿入 

 

 

 

 

 

 

 

 

 

 

 

 

 ① 

② 

③ 

④ 

⑤ 

レ 
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6. 拡張された画面で、下の表に従って各種設定変更を行います。 

 

注意 Scan resolution が 5 ミクロンになっていることを必ず確認してください。 

7. “Output path”で、スキャン画像を出力したいフォルダを指定します。 

8. 設定が終了したら、”Set Values”をクリックします（Set values をクリックしないと変更が反映されませ

ん）。テーブル内の設定値が変更されたことを確認してください。 

9. スキャン設定が確認できたら、”Scan Slot n-m”をクリックするとスキャンが開始します。 

10. スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

11. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

【参考】 XDR スキャン 

※ eXtended Dynamic range：XDR スキャンは、１枚のスライドグラスを、異なった PMT（4x44K フォーマッ

トの場合、高 PMT：XDR Hi 100％、低 PMT：XDR Lo 10％）に変え、自動的に連続スキャンする機能で

す。Feature Extraction 9.1 以降はこの２つのスキャンを自動的に１つにまとめ、広いダイナミックレン

ジが得られる結果を自動的に出力することが可能です。 

 

 

 

5 Green 
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≪スキャンのデフォルト設定変更法≫ 

1. スキャナコントロールソフトを立ち上げ、ツールバーの Settings > Modify Default Settings を選択

します。 

2. 表示された Default Setting ボックス内で、変更したい項目を変更し、OK をクリックします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. スキャナコントロールソフト ver.8（C バージョンスキャナ）をお使いの場合 

1. 画面下の”Scanner status”が『Scanner ready』になっていることを確認します。 

2. スライドを入れたスロット番号を、”Start slot”と”End slot”で指定します。 

 

 

 

 

 

 

 

 

 

 

 

3. “Profile”リストから、既存のプロファイルを選択します。 

<default> プログラムインストール後に現れるデフォルト設定 

 AgilentHD_GX_2Color 遺伝子発現アレイ 2 カラー 

AgilentHD_GX_1Color 遺伝子発現アレイ 1 カラー 

AgilentHD_CGH  CGH/ChIP マイクロアレイ 

AgilentHD_miRNA  miRNA マイクロアレイ 

① 

② ③ 

⑤ 

④ 
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4. 選択したプロファイルの項目で、個別に変更する必要があればプルダウンで変更します。 

変更できる項目(太字に defalt です) 

 1). Dye Channel: Red （1 カラー(Cy5)） 

 Green (1 カラー（Cy3）), 

 Red+Green （2 カラー） 

 

 2). Scan Region: Full Slide 

 Agilent HD (アジレントアレイ) 

 

3). Scan Resolution: 2um, 3um, 5um, 10um, 

 double path (2um, 3um, 5um) 

 

4). TIFF file dynamic range: 20bit, 16bit  

※下記参照 

 

 

5). R/G PMT gain: 100% ～ 1% 

6). XDR ratio: 0.5, 0.33, 0.2, 0.1, 0.05, 

 NoXDR 

 

7). Output Path:  

※ 変更した設定は Profile に保存することができます。 [Profile>Save as] 

 

5. スキャン設定が確認できたら、”Scan Slot n-m”をクリックするとスキャンが開始します。 

6. スキャンが終了したら、Scan Progress 画面の右下にある Close ボタンをクリックします。 

 スキャナのロックがはずれ、スライドホルダを取り出せるようになります。 

7. コントロールソフトを閉じた後にスキャナおよび PC の電源を消してください。 

 

【参考】 16bit スキャンと 20bit スキャン 

※TIFF ファイルに保存されるシグナル強度範囲を指定します。 

20bit スキャンは、1 回のスキャンで 5 桁のダイナミックレンジでシグナル強度を保存できます。XDR スキ

ャンは不要なため、20bit スキャンを選択すると XDR 機能はオフになります。 

16bit スキャンは、1 回のスキャンでは遺伝子発現のダイナミックレンジをカバーしきれないため、XDR 機

能を使って 2 回の PMT gain の異なる連続スキャンを行ない、その結果を統合して使います。この場合、

XDR ratio を指定する必要があります。遺伝子発現のデフォルトの XDR ratio は 0.1 です。 

20bit で 1 回スキャンしたデータと 16bit で XDR スキャンしたデータは、結果にほぼ違いはありません。 



46 オリゴ DNA マイクロアレイキット プロトコル操作実習テキスト 

ログスケール 

リニアスケール 

切り替えボタン 

 

白黒反転表示白黒反転表示

 

11. ハイブリダイゼーション後のマイクロアレイ画像確認 

 

実習では、Feature Extractionソフトウェアによるイメージの簡単な確認法をご紹介します。より詳細につ

いては、Feature Extraction 英語版マニュアルをご覧ください。 

 

① Feature Extraction ソフトウェアの起動 

スキャンした画像ファイルを開きます。 

tif イメージファイルをデスクトップの Feature Extraction ショートカット  にドラッグ＆ドロップ。 

 

 

② バックグランドのむらの確認 

ログスケール表示によりバックグランドのむらを確認します。 

 

 

 

 

 

 

③ 表示カラーの変更 

Color > xxxxx を選択すると表示カラーが変更します。 

例：Color > Reverse Gray Scale を選択すると、白黒反転表示になります。 
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④ イメージデータのスケールの確認 

Green チャンネルのデータレンジを確認します。 

注意 ここでの確認はイメージデータ全体に対するものとなります（スポット以外のエリアも含みます）。 

スポットレベルで確認する（例：コントロールスポットを除く全遺伝子スポットに対してデータスケールを確認する）

ためには、スポット定量が必要になりますので御注意ください。 

 

カラーレンジの設定 

  をクリック。 

イメージデータ全体に対し、１％から９９％の設定 

（デフォルト）における最大値・最小値を確認します。 

 

 

⑤ クロップモードの ON/OFF 

クロップモードが ON の場合、ポインタの横にひし形のマークが表示されます。イメージをクロップすると

新しいウィンドウで切り取った画像が表示されます。OFF の場合、クロップ時にその大きさに合わせてウ

ィンドウが拡大表示されます。 

をクリックすることで ON/OFF の切り替えができます。 

 

⑥ ラインプロット 

スポットの形状を確認します。 

 

 

 

 

 

 

 

 

 

 

 

 

クロップモードを ON にしたまま、ラインプロットを見たい領域の左上隅で左クリックし、そのままポインタを領域

の右下隅までドラッグさせます。次にクロップモードを OFF にし、ラインプロットを見たい位置（上の図の場合、

赤線上のどこでも構いません）にポインタを合わせてダブル左クリックします。 

このように、Feature Extraction する前に、ヒストグラムやラインプロットを使ってデータ抽出の妨げの可

能性となる異常スポットやバックグランドの確認をすることができます。 
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12. Feature Extraction ソフトウェアで数値化を行う前に 

Feature Extraction 画面（ウインドウの構成）の説明 

Feature Extraction Ver.8 以降の画面は、Project Work Window（スポットの数値化の画面）と Image 

Work Window（イメージ確認の画面）があります。 

Project Work Window の画面構成（デスクトップ上の Feature Extraction ショートカット  

から立ち上げた場合の初期画面） 

 

 

 

 

 

 

 

 

 

 

※Agilent カタログアレイの Design File、Agilent が推奨している Default 設定の Protocol は、Feature 

Extraction をインストールする際に、自動的にインストールされます。しかしながら、最新版の Design File、

Agilentが推奨している Default設定の Protocolは更新される場合があります。最新版 Design File、Protocol

の後述の弊社 Web サイトからのダウンロードが可能です（p.59-60）。 

Grid Template Browser 内に、新規 Design File を加える場合 

ダウンロードした Design File を解凍し、XML ファイルを”日本語が入らないパス”のフォルダに保存します。

Grid Template Browser Pane 上で右クリック→Add…を選択後、目的の Design File を選択して下さい（ま

たは、Tools > Grid Template > Add…を選択後、目的の Design File を選択）。 

※圧縮ファイルを解凍する際は、Winzip あるいはWindows XP以降に付属のソフト（解凍するファイル上で右

クリック＞Open with（プログラムから開く）＞Compressed(zipped)Folders と選択）を使用してください。 

各 Design File に Default の Protocol を設定する方法 

Grid Template Browser Pane に格納されている目的の Design 

File を選択します。左ダブルクリック（または、Tools > Grid 

Template > Properties を 選 択 ） 後 、 FE GridTemplate 

Properties（左図）の window が開きます。Default Protocol、

Default One Color Protocol に適切な Protocol を指定します。 

FE Protocol Browser 内に、新規 Protocol を加える場合 

FE Protocol Browser Pane 上で右クリック → Import…を選択

後、目的の Protocol を選択して下さい。 

（または、Tools > FE Protocol > Import…を選択後、目的の Protocol を選択） 

Grid Template Browser インストール済みの 

Design File または Grid File のリスト表示。 

FE Protocol Browser 各数値化ステップの 

アルゴリズムのパラメータを含む、アプリケー 

ションごとのファイル。ダブルクリックで開いて 

変更・保存可能。 

Project 

Explorer  

Pane 

Project Work Window 

QC Metric Set Browser 各アプリケーション 

での QC メトリックのセット。 
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13. Agilent Feature Extraction ソフトウェアによる数値化 

Step 1 Feature Extraction ソフトウェアの起動 

Project Work Windowを以下の方法で立ち上げて、スポットの数値化を行います。 

 デスクトップのFeature Extractionショートカット  をダブルクリックします。このショートカットは

Feature Extraction ソフトウェアをインストールした時に自動的に作成されます。 

 Start>Programs>Agilent >Feature Extraction からソフトウェアを開始させます。 

 

Step 2 FE projectへ数値化するイメージ(.tif)を追加 

1. ツールバーにあるAdd New Extraction Set(s)のアイコン を ク リ ッ ク し ま す 。 あ る い は 、

Project Explorer内で、右クリックをします。そして、Add Extraction…を選択します。 

2. tif.ファイルを選択して、Openをクリックします。複数のファイルを指定するときには、ShiftまたはCtrlキー

を押しながら選択します。 

※ XDR設定でスキャンしたtif画像は、2種類（1st(H)および2nd(L)）のScan Fileがイメージファイルとして

認識されます。その際、1stおよび2ndのScan Fileが、同一フォルダ内に存在する必要があります。 

 

3. Project Explorer内のProject下の階層にExtraction Setが、さらにExtraction Set下の階層にImage 

File、Grid Template（あるいはGrid File）、Protocolが現われることを確認して下さい。必要に応じて、

適切なGrid TemplateとProtocolを選択してください。 

Project： Feature ExtractionのRun設定全体をまとめた情報です。1つ以上のExtraction Setから構成さ

れています。 

Extraction Set： 解析する tif 画像ごとに作成されます。Image File、Grid Template (Grid File)、

Protocol から構成されています。 

Image File： 解析対象のマイクロアレイ画像のことです。 

Grid Template (Grid File)： Grid 情報です。Agilent アレイのお客様は、Design File を意味します。 

Protocol： イメージの数値化の際、適用する解析アルゴリズムの設定です。 

 
Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project

Extraction Set

Image File

Grid Template (Grid File)

Protocol

Project
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Step 3—Project PropertiesおよびExtraction Set Configurationタブシートでの設定

および確認 

１ Extraction Set Configurationタブシートの確認をします。 

 Extraction Set Configurationタブシートを選択。 

 Extraction Setで用いる構成（イメージ、Design File、Protocolなど）を設定、確認します。 

※ Protocol は8x15K, 4x44K, 2x105K, 1x244K フォーマットアレイの１色法の数値化には、

FE9.1ではGE1-v5_91_日付、FE9.5ではGE1-v5_95_日付、FE10.5ではGE1_ 105_日付、

FE10.7ではGE1_107_日付を選択してください。 

Design FileについてはP.59、 ProtocolについてはP.60をご参照ください。 

 

※ XDR設定でスキャンしたtif画像は、2種類（1st(H)および2nd(L)）のScan Fileがイメージファイルとして認識

されます。その際、1stおよび2ndのScan Fileが同一フォルダ内に存在する必要があります。 

プルダウンメニューにgrid templateがない場合に、grid templateをGrid Template Browserに追加してく

ださい。Grid Template Browserの枠内で右クリックをして、Addを選択します。追加したいデザインファイ

ル(.xml)をブラウズし、Openをクリックしてデータベースにインポートします。最新のgrid templateにアップ

デートする場合には、オンラインアップデートをご利用ください。Grid Template Browserの枠内で右クリッ

クをして、Online Updateを選択します。 

2. Project Propertiesタブシートでの設定確認、および設定を行います。 

 Project Propertiesタブシートを選択する、あるいは、Project Explorer内の解析に用いるProjectをダブ

ルクリック。 

 Projectの設定を確認、変更をします（解析結果ファイルのOutputフォルダの設定、結果としてOutput

するファイル種類の設定など）。 

 

Extraction Set Configurationタブシート 
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①出力方法の設定 

出力方法は以下の4つから選択することができます。 

None （出力しない） 

Local file only （ハードディスクに出力する） 

FTP send only （外部にファイルを転送する） 

Both local file and FTP send （両方に出力する） 

 

本実習では、TEXT、Visual Results、QC Reportの結果を出力します。これらの項目の設定を、Local file 

onlyと選択します。また、それ以外の項目（MAGE、JPEG、Grid）は、Noneを選択します。 

 

②出力ファイルの設定 

MAGE アレイの結果をXML形式で出力。解析にロゼッタ社のリゾルバー/ルミネーターを使用する

場合、Array Expressにデータを転送する場合などに必要。 

JPEG 各アレイ画像をJPEG形式で出力。この画像ファイルからは数値化はできないので注意。 

TEXT アレイの結果をタブ区切りテキスト形式で出力。解析にGeneSpring、エクセルなどを使用

する場合に必要。 

※ TEXTファイルのOutput 設定は、以下のOutput Package設定が可能です。 

Full： 数値化項目全ての結果を出力します。 

Compact ： 数値化項目の一部（通常、データ解析に用いると考えられる項目）の結果

を出力します。Fullに比べ、約1/3のファイルサイズとなります。 

GeneSpring, DNA Analyticsを使用する場合はCompact推奨。 

Visual Results 数値化結果のTIFF画像へ重ね描きするのに必要な.shpファイルを出力。 

Grid グリッド合わせの詳細（スポット位置情報など）をCSV形式で出力。 

QC report 実験の成否をチェックするための項目を含んだレポートを出力。 

※ QC reportはPDFファイルあるいはHTMLファイルで出力できます。 

PDFファイルは ”Local PDF file only” を、HTMLファイルは ””Local HTML file only” を

選択してください。64bitのPCをお使いの場合は、”Local PDF file only” を選択しても

HTMLファイルが出力されます。HTMLファイルの場合は数値化後、必ず

QCReport_Graphsというフォルダと同じフォルダにHTMLファイルを保存してください。 
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Feature Extraction 9.xでQC metricsを出力するにはQC Metric Setの項目GE1_QCMT_日付を選択し

ておきます。Feature Extraction 10.x以降はデフォルト設定で出力されます。 

 

 

3. 設定を確認したら、Projectの保存を行います。 

 File > Save As後、Save Asのダイアログ画面が出てきますので、FE Project Data Files (.fep)ファイ

ルを保存するための適切なフォルダを選択および作成して下さい。 

 フォルダ指定後、名前を付けて保存して下さい。 
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Step 4—Feature Extraction Projectをスタート 

Project > Start Extractingを選択すると、Projectがスタートします。 

スタート後、Summary ReportタブとRunning Monitorが現われます。 

 

 

 

 

 

 

 

 

進行状況は、Running Monitorに表示されます。Project終了後、Summary Reportタブを選択していると、

Project Work Windowに、Project終了を示すSummaryが現われます。 

 

※ 4x44K フォーマットの出力結果は、ファイル名末尾 ”…_1” ～ “…_4” の4つのデータが得られます。 

8x15K フォーマットの出力結果は、ファイル名末尾”…_1_1” ～ “…2_4” の8つのデータが得られます。 

それぞれ、下図の位置のアレイに対応しています(バーコードラベルを左側、Inactiveサイトが手前の状態)。 

 

 

 

 

 

Summary ReportタブシートSummary Reportタブシート

 
 

1 2 3 41 2 3 4
1_1 1_2 1_3 1_4

2_1 2_2 2_3 2_4

1_1 1_2 1_3 1_41_1 1_2 1_3 1_4

2_1 2_2 2_3 2_42_1 2_2 2_3 2_4

Running MonitorRunning Monitor

Project 終了後Project 終了後
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Step 5—QC Reportの確認 

 

1. 出力ファイルの設定で、QCReportを選択した場合に自動でQCReportが作成されます。 

2. ”pdf形式のQCReportファイル”を開いて下さい。QC Reportを確認することができます。 

 

QC Reportは、以下の項目を示します。 

（各項目の詳細は、Help > Reference Guideの各ページで確認することができます。）  
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出力された

QC metrics

のテーブル 



 56 

Step 6—Visual Resultの確認 

 

Step3で選択したVisual Resultファイルを使ってフラグ等の確認をします。 

1. Feature Extraction内に、XDRスキャンをした1stの画像（ファイル名の末尾に_Hが付いた画像）を表示さ

せます。 

2. メニューバーのFeature Extraction > Load Visual Resultを選択します。 

3. 該当するVisual Resultファイル（.shp）を選択します。このとき表示させている画像に対応するファイルを

選択してください。 

4. 画像にVisual Resultが重ね描きされます。 

5. クロップモードやズームイン機能、ログスケール表示機能を使って表示を調節します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. View > Extraction Results からVisual Resultsの表示法を選択できます。 

 

 

 

 
 

     View outliers onlyにチェックが入っている状態 

 

Help > Feature Extraction Output Quick Referenceで各リングの色が示すアウトライヤーを確認できます。 
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Step7. テキストファイルの確認 

以下の表は、Compact 設定で出力されたテキストファイルの主な項目です。 

通常データ解析では gProcessedSignal をシグナル値、ProbeName を ID として使用します。 
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Feature Extraction 由来のフラグ 

 コントロールスポットの排除： ControlType→０にします。 

(Agilent コントロールは１または-１で表示されています)。 

 サチュレーションのフラグ： gIsSaturated 

サチュレーションしたスポットは１、していないスポットは０で表示されています。 

 

 各種フラグ： 

① スポットのフラグ gIsFeatNonUnifOL、gIsFeatPopnOL 

② バックグランドのフラグ gIsBGNonUnifOL、gIsBGPopnOL 

- NonUnifOL は各スポット(バックグランド)内のむら、均一性をみた項目です。 

（１がフラグ、０がフラグのたっていないスポット）。 

- PopnOL はあるプローブが複数アレイにプリントされている場合、それらのプローブスポット

間で均一性があるかをみる項目です（１がフラグ、０がフラグのたっていないスポット）。 

 

 バックグランドと有意差がないシグナルスポットのフラグ： gIsPosAndSignif  

両側 t 検定により有意差判定を行います。 

（シグナルが有意である場合は１、差がない場合は０で表示されています。) 

 

 ある閾値よりも低いシグナルスポットのフラグ： 

BGSubSignal の値が、バックグランドの標準偏差*を各アレイフォーマットの最適値倍(2.6 ある

いは 13xBGSD：低密度フォーマットは 2.6、高密度フォーマットは 13 が Default)した値よりも大

きいか小さいか、で判定を行います。 

*標準偏差は、1)低密度フォーマット：ピクセルレベルのばらつきを考慮した値、2)高密度フォー

マット：エラーモデルから算出された値を用いております。 

gIsWellAboveBG 

（このクライテリアよりもシグナルが高い場合は１、低い場合は０で表示されています） 

gIsPosAndSignif よりもクライテリアが高くなり、カットオフされる低シグナルのスポット数が多く

なります。 
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スポット数値化と解析 

DNA マイクロアレイの解析には 2 種類のソフトウェアを使用します。 

 

まずスキャンで得た TIFF イメージからスポットの数値化を行うソフトウェアが必要になります。ここで

はスポットのシグナル強度、ローカルバックグランドのシグナル強度などが算出されます。Agilent ス

キャナーに付属する Feature Extraction ソフトウェアはこれに加えてバックグランドの引き算を行い、

最終的なシグナル強度（Processed Signal）を結果として出力します。 

 

上記のスポット解析を行った数値データを用いて、高度なデータ解析を別のソフトウェアで行います。

データ解析を行うソフトウェアは数多く製品化されていますが、本トレーニングではエクセルで基本

的な解析を行い数値化のアウトプットデータを理解した上で、Agilent GeneSpring GXを使ったデモを

行い、さらに生物学的意義を付け加えていきます。 

 

Agilent Feature Extraction など Agilent GeneSpring GX 

など 

図：スポット解析、データ解析の流れ 

 

スポットの数値化は以下の手順で行われます。 

① スポットの中心位置の決定 

② スポット（Feature）およびバックグラウンド領域の決定 

③ スポット（Feature）のシグナル強度計算 

④ バックグランドのシグナル強度計算 

⑤ バックグランド補正 

⑥ Multiplicative Detrending 

これらのステップ後、最終的なシグナル強度（Processed Signal）が出力されます。 

 

注意 Surrogate 設定を含まない Protocol の場合、バックグランド補正の結果、Processed Signal

の値がマイナス（－）値になる遺伝子プローブがあります。多くの場合、これらは発現をして

いない遺伝子プローブと考えられます。数値化プロトコルのデフォルト設定は Surrogate が

ON になっています。 

※ Processed Signal の値がマイナス（－）値になる遺伝子プローブのデータ処理について

は、1 color 実験の Normalization、Data Transformation をご参照下さい（p.61）。 
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バックグランド補正 

アレイのイメージ結果によって、以下の減算法が挙げられます。 

 ローカルバックグランド 

 全ローカルバックグランドの平均値 

 ネガティブコントロールのバックグランド 

 アレイイメージの最低シグナル値（スポット、バックグランド含む） 

 スポットの最低シグナル値 

ローカルバックグランドはスポットの周囲でプローブがスポットされていない部分になります。 

 

また、以下の補正法が挙げられます。 

 Spatial Detrend 

 Global Adjustment 
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Appendix1：total RNA の質チェック 

Step1．UV-Vis による Total RNA の評価 

本プロトコルでは、測定に用いるサンプル量を抑えるため、NanoDrop の使用をお勧めいたします。 

NanoDrop を使用する場合は、メニュー画面で Nucleic Acid Measurement をクリックし、Sample Type

は RNA-40 と選択します。 

 少なくとも、以下の 4 つの波長における吸光度を測定して下さい。 

A230   グアニジンイソチオシアネートや塩類・糖類、その他有機溶媒などの混入を検出します 

A260  TotalRNA の濃度を測定します 

A280   タンパク質・フェノールの混入を検出します 

A320   異常な吸収がないかをチェックします 

 以下の基準を満たしているかをチェックして下さい。 

A260/A280＝1.8～2   A260/A230>2.0  

この基準を満たしていない場合、たんぱく質や有機溶媒の混入が疑われ、ラベル化反応がうまくい

かないことが予想されます。また、RNA を正確に定量できていない可能性もあります。抽出をやり直

すか、混入物を除去するための追加の精製を行って下さい。 

 

 UV スペクトルを採取し、スペクトルパターンを記録して下さい。 

純度の高い核酸のスペクトルは、230nm に谷、260nm に吸収極大があり、長波長側の吸光度

は 0 で安定しています。 

Step2．Agilent 2100 Bioanalyzer による total RNA の評価 

UV-vis の測定結果からは RNA がどのぐらい分解しているかを知ることはできません。必ず電気泳

動で RNA が分解していないか、確認してください。本プロトコルでは、Agilent 2100 Bioanalyzer を推

奨しています。 

Agilent 2100 Bioanalyzer を用いる場合は、サンプルの濃度に応じて、RNA6000 Nano kit あるいは Pico 

kit を使用してください。実際の操作は各キットの説明書に従ってください。 

電気泳動の結果から下記 3 点を確認し、分解していないか評価してください。 

 18s および 28s リボソーマル RNA（あるいは生物種特有の rRNA）の明確なピークが確認できる 

 18s および 28s リボソーマル RNA のピーク間に分解物がない 

 18s リボソーマル RNA ピークと Lower Maker 間に分解物がない 

（5s リボソーマル RNA は精製法によって高さが変わります。カラムを用いて total RNA を精製した場合、

通常低くなります。） 

Agilent 2100 Expert Software は、total RNA の質の指標として RNA Integrity Number（RIN）を自動で算

出します。RIN を使うと、RNA の分解具合などの質の標準化が容易になります。 

RIN や Bioanalyzer に 関 す る よ り 詳 細 な 情 報 は 、 以 下 の ウ ェ ブ サ イ ト よ り 、 “ RNA integrity 

number(RIN)-Standardization of RNA quality control” (part number 5989-1165EN)をご覧下さい。 

 www.agilent.com/chem/labonachip 

http://www.agilent.com/chem/labonachip
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下の図では、分解具合の異なる 3 種類の total RNA を分析した結果のエレクトロフェログラムを示しています。

お客様が、品質の悪い Total RNA による実験結果の偏りを排除するために、RIN の各々の閾値を実験系ごと

に決定することが重要となります。 

 

 

 状態の異なる（ヒト）Total RNA を Eukaryote total RNA Nano assay によって分析した結果 

赤…RIN 8.1 青…RIN 5.9 緑…RIN 3.6 
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Appendix2：Feature Extraction 用デザインファイルのダウンロードサイト 

デザインファイルは eArray からダウンロードすることができます（ご使用の際、ご登録が必要となります）。 

【eArray】 http://www.chem-agilent.com/contents.php?id=29443 

 

1．お使いのマイクロアレイのデザイン番号 (Design ID)を確認します。 

デザイン番号： マイクロアレイのラベルに記載されて

いる 12 桁の番号の「25」に続く 5 桁の番号の頭に「0」

を付けた 6 桁の番号。この 12 桁の番号は Feature 

Extraction の出力ファイルからも確認できます。 

例）12 桁の番号が 251469312345 の場合… [14693]

の頭に「0」を付けた 014693 

 

2．eArray にログイン後、画面右上の 

「Application Type」を Expression に変更。 

 

 

 

 

 

3．HomeタブでMicroarrayにチェックを入れ、Design ID

欄にデザイン番号を入れてSearch。 

 

 

 

 

4．Search 結果から「Download」を選択 

 

 

 

 

 

5．Internet Explorer の Pop Up Blocker

を Off にし、「EXTERNALFULGEML」

（＝Feature Extraction 用デザインフ

ァイル）をダウンロード  

http://www.chem-agilent.com/contents.php?id=29443
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Appendix3：Feature Extraction 用 Protocol のダウンロードサイト 

 

弊社スポット数値化ソフトウェア、Feature Extraction によるスポットの数値化を行う際、イメージの数値

化に適用する解析アルゴリズムを設定した Protocol ファイルが必要です。 

Agilent が推奨している Default 設定の Protocol ファイルは、下記サイトからダウンロードが可能です。 

http://www.genomics.agilent.com/article.jsp?pageId=2037 

 

 

 

※ 2017 年 4 月現在、上記の Protocol のダウンロードが可能です。 

※ プロトコルファイルは、最新のものではなく、お使いの Feature Extraction Software と一致したバ

ージョンをお使い下さい。 

※ 各 Protocol の詳細は、Protocol Use のリンク先をご参照下さい。 

 

 

QC Metric Set のダウンロードサイト 

最新の QC Metric Set は下記サイトからダウンロードできます。Feature Extraction 9.1 以降に対応して

います。 

http://www.genomics.agilent.com/article.jsp?pageId=2041 

 

  

http://www.genomics.agilent.com/article.jsp?pageId=2037
http://www.genomics.agilent.com/article.jsp?pageId=2041


 

オリゴ DNA マイクロアレイキット プロトコル操作実習テキスト 

 

65 

Appendix4：1 color 実験の Normalization 

 

１color 実験で得られた複数のアレイデータを相互比較するためには、Normalization（正規化）が必要で

す。 

2 つのサンプルを異なる色素でラベル化し、競合ハイブリダイゼーションさせる 2color 実験では、基本的

に Dye Normalization（色素補正）が適用されますが、1 color 実験では、データの特徴と実験の目的

（実験デザイン）を考慮して、適切な Normalization 方法を選択する必要があります。 

ここでは、1 color 実験の Normalization の基本的な考え方を理解するために、GeneSpring GX の設定

を例として、代表的な Normalization シナリオを紹介します。 

 

Normalization Step 

Normalization を行う Step は、大きく分類すると、Data Transformation、Normalization、Baseline 

Transformation の 3 種類あります。 

- Data Transformation の例としては、バックグランド補正の結果生じたデータのマイナス（－）値をプ

ラス（＋）値に変換することが挙げられます。 

- Normalization は、アレイ間のシグナル強度の系統的な誤差を補正して、生物学的な変動を抽出す

ることが目的です。 

- Baseline Transformation は、サンプル間の遺伝子発現の絶対値ではなく、発現パターンの違いに

着目して解析し、生物学的な意味を引き出すために行います。実験デザインにあわせた設定をする必

要があります。 

 

これらの Normalization Step 中には、様々な Normalization のアルゴリズムが存在します。 

下記に、Normalization Step に含まれる代表的な Normalization アルゴリズムを示します。 

実験デザインに応じて、適切な Normalization アルゴリズムを含んだ Step を組み合わせ、

Normalization シナリオを作成します。 

 

Data Transformation 

・【Threshold raw signals to XX】 – バックグランド補正の結果生じ、生物学的に意味のない負（マイナ

ス）の値を引き上げます。GeneSpring のデフォルト設定では、以下の数値を１の値に置き換えます。 

 

Normalization 

・【Percentile Shift】 – アレイごとに、測定値の median または特定の percentile の値を１に揃えます。 

・【Quantile】 – 発現値をランキングし、同じランクの値の平均値を発現量として使用します。 

・【Scale】 – サンプルの中央値を使って補正します。 

・【Normalize to Control Genes】 – アレイごとに、ポジティブコントロールの測定値の median で補正し

ます。この補正は、ポジティブコントロールのターゲットとプローブが、いかなる条件下でも一定量のハイ

ブリダイゼーションを示し、かつハイブリダイゼーションの効率がポジティブコントロールの遺伝子群と、

その他の遺伝子群で同等であるという前提に基づいています。 
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Baseline Transformation 

・【Do not perform baseline transformation】： 補正しません 

・【Baseline to median of all samples】： 発現の絶対量にかかわらず、発現量の変化（発現パターン）に 

 着目して解析する場合に使用します。明確なコントロールサンプ

ルが存在しない場合に使用します。 

・【Baseline to median of control samples】： コントロールサンプルに対する各遺伝子の発現量の増減に

着目して解析する場合に使用します。 

 

―解説 

Normalization 

図１に示した Raw Data の分布を表したヒストグラム（シグナル強度を縦軸においたヒストグラム）では、

他の Sample に比べて、Sample ４（S4）のシグナル強度が、全体的に高くなっています。この場合、

sample ４の真の遺伝子発現が全体的に高いことも考えられますが、この仮定が妥当なものとみなされ

ない場合は、このシグナル強度の違いは、RNA 抽出・ラベル化・ハイブリ・洗浄・スキャニングのムラな

どの実験誤差による影響だと考えられます。 

Normalization は、１枚のアレイ全体のシグナルレベルを補正し、実験誤差による影響をキャンセルする

ことで、生物学的な変動を抽出することを目的としています。 

【Scale】・【Percentile Shift】は、多数の遺伝子を網羅的に搭載したアレイデータを使った場合、大多数

の遺伝子の発現量に変化がなく、その中央値や Percentile 値は各アレイ間でほとんど変動しないとい

う仮定に基づいています。その仮定をもとに、各アレイでの発現強度の Median 値などを使い、全遺伝子

の発現強度（シグナル強度）を割って補正を行います。いわゆるグローバルノーマライゼーションになり

ます。 

この Normalization の結果、Median 値や Percentile 値が 1.0 となる Normalization 値が算出され、各

アレイ（Sample）間のシグナル強度を相互比較することが可能になります（図 1）。 

 

※ アジレントのカタログアレイでは、コントロールプローブを除いた全プローブの、75%tile の値が、

Median の値よりも堅牢であり、この目的の補正には、75%tile の値を使うことを推奨しています。 

（http://www.nature.com/nbt/journal/v24/n9/full/nbt1241.html をご参照下さい） 

http://www.nature.com/nbt/journal/v24/n9/full/nbt1241.html
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注意 対象となる生物種の遺伝子を網羅することを目的としてデザインされたアレイでは、搭載されて

いるプローブ数に比べて、実験に用いる Sample で真に発現している遺伝子が少ない場合があ

ります。この場合、真に発現していない遺伝子プローブが、シグナル強度が低い領域に多数存

在し、その割合の違いが median の値に影響を与えます。 

この影響を避けるには、発現していないとみなされる遺伝子にabsentのフラグがたったプローブ

を除いて、median を計算する方法があります。またフラグが自動的に付かない数値化ソフトウェ

アを使用している場合は、各 Sample で適切な percentile（例：75 percentile）値を検討してもよ

いでしょう。 

 

（参考） 

比較したいサンプル間で、遺伝子の発現量の median 値が一定であるという仮定が成立しない場合、

Normalization 【Percentile Shift】や【scale】は適切なアルゴリズムではありません。 

仮定が成立しない例として、下記の場合が考えられます。 

1. 遺伝子数が少なすぎる（Median や Percentile 値が信頼できない） 

2. 特定の遺伝子のみを意図的に集めたテーマアレイ（大部分の遺伝子の発現が変化する） 

3. 大多数の遺伝子の発現を変えるような状態、あるいは処理を行った 

このような場合には、【Normalize to Control Genes】が選択肢のひとつとして考えられます。Control 

Gene は、ハウスキーピング遺伝子に代表される遺伝子群（常に一定のレベルで発現していることが期

待される遺伝子群）や、一定量に調製されたスパイクコントロールサンプルに対応するプローブなどがあ

ります。ただし、この方法は個々の Control Gene の発現レベルが変動した場合、結果に大きな影響を

与えます。ハウスキーピング遺伝子群を用いる場合は、できるだけ多くの Control Genes を設定し、その

Median 値を使うと、より保守的な Normalization になります。 

Median ( 50 percentile)

S 1 S 2 S 3 S 4

1.0

S 1 S 2 S 3 S 4

Per Chip: Normalization to median

適用後

Raw Data

図1. Per Chip: Normalize to median (50 percentile)
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Baseline Transformation 

Normalization の後に、サンプル間の遺伝子の発現量の違いではなく、発現パターンの変化に注目して、

生物学的な意味を抽出するのを助ける目的で行います。発現量の多少にかかわらず、同じときに発現

量が増えたり減ったりしている遺伝子は、①機能的に近い関係にある、②同じ転写制御の元にある、③

同じカスケードの下流にある、といった仮定にもとづいて解析を行う場合に有効です。逆に、この

Transformation により、すべての遺伝子が１の周りの変動に収束するので、発現量の絶対値に注目し

た解析を行う場合は、この Transformation Step は必要ない、もしくは不適切な場合があります。 

 

例１ 明確なコントロールサンプルがない場合 

【Baseline to Median of all samples】は、特にコントロールサンプルが存在しない実験デザインの場合

に用います。 

Baseline to Median of all samples の計算例を図 2 で示します。図 2 は、5 つの Sample 中での、遺伝

子 A と遺伝子 B の動きを示しています。遺伝子 A では S5 の値が、遺伝子 B では S3 の値が median

になります。よって、遺伝子 A では S5 の Normalization 後の Normalized 値で各 Sample の値を、遺

伝子 B では S3 の Normalized 値で各 Sample の Normalized 値を割ります。結果として、遺伝子 A で

は S5 の値が 1.0、遺伝子 B では S3 の値が 1.0 となります。 

 

Normalization を適用した段階では、発現量の絶対レベルによって、Normalized 値が示されます。次に、

Baseline to Median of all samples を適用すると、全ての遺伝子が１の周りの変動に収束してきます。 

 

 

 

S 1 S 2 S 3 S 4 S 5

1

2

3 (Median)
4

5

1

2 3 (Median)

4

5

S 1 S 2 S 3 S 4 S 5

1.0

1.0

Per Gene Normalization:

Normalize to median

適用後

明確なコントロールサンプル
が存在しない場合

図2. Per Gene: Normalize to median

A

B

A

B

Baseline Transformation 

明確なコントロールサンプルがない場合 

Baseline Transformation 
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例 2 コントロールサンプルに対する比較実験の場合 

 

コントロールサンプルに対する比較実験の場合は、Step3 で、【Baseline to median of control samples】

を適用します。コントロールサンプルの各遺伝子の Normalization 後の Normalized 値で、全 Sample 

の Normalized 値を割ります。コントロールサンプルの Normalized 値は１になります。それ以外の

Sample で１より大きな（小さな）Normalized 値を得れば、その Sample ではコントロールサンプルより

も発現が高い（低い）ということができます。Baseline to median of control samples の例を図 3 に示します。

この例では、S1 がコントロールサンプルであり、遺伝子 A、B ともに S1 の値で各 Sample の値を割りま

す。その結果、遺伝子 A、B は、S1 の値が 1.0 になっています。 

 

Median もしくは Specific Sample のどちらを使用した場合も、Baseline Transformation の適用によ

り、全ての遺伝子の Normalized 値は１の周りに収束してきます。 

 

 

 

 

 

 

 

 

 

S 1 S 2 S 3 S 4 S 5 S 1 S 2 S 3 S 4 S 5

1.0

S1が明確なコントロールサンプル

の場合
Per Gene Normalization:

Normalize to Specific Samples

適用後

図3. Per Gene: Normalize to Specific Samples

A

B

A

B

Baseline Transformation 

Baseline Transformation 

明確なコントロールサンプルがある場合 
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Appendix5：マイクロアレイのレイアウト 

 

キットに付属のデザインファイルには、アレイの各プローブの位置情報（レイアウト）やアノテーション情報が含

まれております。このデザインファイルは、アジレント DNA マイクロアレイスキャナーで読み取った向きを基準

として作成されております。弊社のスキャナはアレイ面を裏側にから、またバーコードを左位置で読み取るの

で、ほとんどの他社製品のスキャナで読み取ったイメージと向きが異なります。数値化データとプローブ情報

を組み合わせる際には、お使いのスキャナの読み取り方向にあわせて並び替えたデザインファイルをお選び

頂く必要があります。並び替えたデザインファイルもマイクロアレイキットに付属の CD-Rom に含まれておりま

すので、次の点をよくご確認したうえ、適切なデザインファイルをお使いください。 

 

1) アレイの表面側(front side)からスキャンしているか。(バーコードにAgilentの文字がある側からスキャン) 

2) 得られたイメージ画像が、スライドグラスを横方向（landscape）にスキャンしたものか。縦方向（portrait）

にスキャンしたものか。バーコードが得られたイメージに対して、上下左右のどこに位置しているかでご判

断ください。 

 

 

デザインファイル名には、アレイ種類（Design ID）とファイル更新日の情報が含まれております。 

 

デザインファイル名の例： 

 

 

 

 

 
(Design ID) 
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Appendix6：弊社 DNA マイクロアレイサポート用ホームページ 

弊社の DNA マイクロアレイサポート用ホームページでは、上記のほかにも新製品や最新プロトコル、アプリケ

ーションノートなど様々な情報を掲載しております。 

(アメリカ本社ウェブサイト)  http://www.genomics.agilent.com/en/home.jsp# 

本社のサイトに掲載してありますキャンペーンの中には、日本国内ではご利用いただけないものもございま

すことをご了承ください。 

 

アジレントゲノミクス 日本ウェブサイト 

 

 

 

 

 

 

 

 

http://agilentgenomics.jp 

 

 eArray  

 実験に必要なものリスト 

 サポートページ 

サポートページにて、最新版の和文マニュアルを 

ダウンロードすることができます。 

http://agilentgenomics.jp/
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すべての権利は留保されています。著作権法で認められている場合を除き、本書を許可なく複製、改作、

翻訳することは禁止されています。 

 

本和文操作実習テキストの版権は全て Agilent Technologies, Inc.が所有しています。 

 

ご注意 

本書に記載した内容は、予告なしに変更することがあります。 

本書は、内容について細心の注意をもって作成いたしましたが、万一ご不審な点や誤り、記載もれ等、

お気づきの点がございましたら当社までお知らせください。 

当社では、下記の項目を補償の対象から除外いたします。 

ユーザーの誤った操作に起因する機器などの損傷、性能上のトラブル、損害 

本キットの本来の用途以外の使用に起因する機器などの損傷、性能上のトラブル、損害 

本プロトコルに以外の方法または試薬を用いたことによる性能上のトラブル、損害。 

 

分析結果に基づく損失 

本書の内容の一部または全部を無断で複写、転載したり、他の言語に翻訳することは法律で禁止され

ています。複写、転載などの必要が生じた場合は、当社にお問い合わせください。 

本製品パッケージとして提供した本マニュアル、CD-ROM 等の媒体は本製品用にだけお使いください。 

 

保証 

本書に記載した内容は、予告なしに変更することがあります。 

Agilent Technologies は、本品に関していかなる保証も行いません。これには暗黙の保証、または商品

性および特定目的への適合性が含まれますが、それらに限定されません。 

Agilent Technologies は、本書に含まれている誤植、あるいは本品の性能、または使用に関する偶発的

ないし間接的な損害に関して責任を負いません。 

 

 


